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First steps 1

1 First steps
1.1 First steps with AquaSoft ® SlideShow

=8 AquaSoft Slid Ultimate [New slideshow.ads™]
File Edit Slideshow Add Extras Wizards Workspace Help

DoBEs 8D b Q& E

Open.. Add | Music Settings .. from here ompm Search | Default Storyboard Imagelist Toolbox

| mmageetecs | Teeffects | Movemercoste NS (52 B 0 O (B % & | % B T - Tmemarke povsec 2| kst = o B
v|show ebiect
£ Duration: SOUsEc

FEEa)

First steps

Movement paths

| Sideshow abjects | Fadeins | Fadeouts

Templates for the design of your slideshow: Simply dragaing a template
to the tmeline adds a corresponding obiject, Also have alockatour %

‘ Image | T rext | Text | 111 ] Sound |§ L
[l Default

-

- T W'WE@, =1 ::;

Soud  Chapter Fled-Collage

Fatel: [ranion - ||
E @

Fade out: Leave in place (dor ~ | |ﬁ‘

- Background

LA
Partide  Placsholier
= Effects

NV NN

DEPMMM%I(EWKI Photo cologe Gallry  FENEUTS gy cffcct

|putomatic (er) - | F

[ Route animations

Alignment: | Center -
| |Rotate in direction of mavement

Click here toadd backgray
Mote: the musictrack remains empty aslong 3s thesi

Images can also use the plus icon to be added

1. Add images

Click the Plus-button —I i

in the Toolbar and add your images. If you want to add several
images at once hold down the Ctrl-key and click the images with the mouse.

> In chapter "Adding images" you'll learn about other ways to add images.

> If you want add captions to your images please read chapter "Text to images”.

» How to annotate images with an audio commentary, see chapter "Sound Wizard".
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D Sl|deshnw

-~ Main settings
Slidezhioty Ao
Transitions

Muzic: settings
Background rrusic

Description

Loga Users'\F‘ubIlc'\MusmkSample ... 5 aid with the Fla:-ten Hair.mp3
- SlideShaw-Player A\ Uzers\PublichMusichSample Musich\Sleep Away.mp3
“ Standard Player (Directs)

Adding background music

2. Adding background music

Click the Music-button - in the Toolbar. This will open the menu for the background

music with an empty playlist. You can add songs using the Plus-button in the menu.
Confirm with OK to load the songs into the show.

» In chapter "Background music" you can read everything about music in your
slideshow.
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= Aquaot SlideShow Ultimate [Helpt ads]
Eile Edit Sideshow Add Extras Wizards Workspace Hel
= [EL]
D.Erl|-%-vd‘ﬁl> b @ A B E H B
New  Open.. Save | Add  Music Settings | play b fromhere | Output | Scarch | Default Storyboard Imagelist Toolbox First steps
Toolbox
| mageeffects | Texteffets | Movementpat el [o,00 Object settings
| Sideshow objects | Fadeins | Fadeo ¥/ Ishow object
gone [ 0cec = |
Tempiates for the design of your sideshow: Simply dragging a templa e

to the tmeline adds a corresponding object. Also have a look at our _

i ‘ Image |7T Text | o) Sound |¥ L
DO LB

= File name
i’Z:W\gamein\ﬁraph\x\Gekauﬂ\shutberstod [=3 }

=l Default

Bl F =1
b T B 5 &

=L ™
Image Test video Sound

- Transition

5 Fadeini  [Raom ||
ik Fedeouts | Lesver pisce dor + | |

Partie  Placsholder
[ Effects

Dplocement oy stfes Photo colzge Gal Ken Bums gy shfect PETErE—
e colage Galley e Aspectratio:  |Crop inteligenty -|
El Route animations e,
= T Alignment: | ‘&’ Center -
=gy -r >
- — | |Rotate in diraction of movement
[Filter x Q= 0 > b [la & of wef | oo0o.000 |
Timeline
e S e T I R T T T T T
4 = b4 = d T d B : P = 2 4 @ 4 =
y
=
o
i = T’ ,,,,, & =

Playing in full screen mode

3. The show can begin
In two steps you have inserted images and music and can now play the show. Click the Pl/ay-button

—I inthe Toolbar or press the F9-key.

The transitions from one image to another are selected at random.

> In chapter "Transitions" you'll learn how you can define these yourself.

1.2 Program overview

Structure of the user interface

AquaSoft ® SlideShow includes several tools to edit your show. In the following graphics you get
an overview over the available controls. We will talk about objects often. All elements that can be
added to a slideshow, e.g. images, text, music or collages, are objects.
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The description of the controls is given with respect to the Layout view. You can select
i itvia View -> Layout.

-

| 2 Aquesoft Slideshow Uttimate [New sideshow.ads]

E=mjEen
File Edit Slideshow Add Extras Wizards Workspace Help
Df’j.| VJ#‘D b @ & EH B H OB
Open.. Add | Music Settings ol sk B Deisiit St arpboa B st ) oo First steps

O 1 X Objectsettings o x

| Text effects Movement paths

| Sideshow abjects | fadeins | Fadeous

:H

Templates for the design of your sideshow: Simply dragaing = template
to the tmeline adds a corresponding object. Also have alock atour . %

(= Default

- T m-«w[ﬂ;ﬂ]ﬁ

Sond  Chapter Fres-Collage

7| Teolbex Leyeuk designer Oljjeet sstiings

Patide  Placeholder
& Effects ———————

R EEINN

“EP"E'“E""Maskeﬁenpmoolbge Galery KBS g affe

=] Route animations -

[Fiter x - @ P> bk (ke K o e | 00:00.000

Click here toadd background misic
ptyasiong a

The toolbar

| =B Aquasoft SlideShow Uttimate [Helpl. ads"]
File Edit Slideshow Add Extras Wizards Workspace Help

DE‘rI ?J‘ﬁ| I>

Open... Save | Add | Music  Settings ... from here

D vl Creates a new empty show.

Opens an existing show.

@ B [E O

Output | Search | Default Storyboard Imagelist Toolboot

Saves your show.

Adds images to your show.

1% @ (O
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Opens the dialog to add background music.

=
<,

Opens the slideshow settings. The settings only apply to the currently opened show.

Plays your show from the beginning.

Plays your show from the current position.

Opens the Export Wizard.

Allows searching for text, file names and keywords inside your slideshow.

Loads SlideShow's Layout view.

Loads SlideShow's Storyboard view.

Loads SlideShow's Image list view.

Loads SlideShow's Toolbox view.

3 = E E R e 5T V|3

The Layout Designer

The Layout Designeris your preview window. Here you can see how images and text will be
displayed on the monitor.
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Layout designer o QL x
4’ |%’ 'ﬁ;-ﬁ'ﬂz Time mark: (0,00 sec =

-

The following icons are available in Layout Designer:

ml Zooms into the preview in Layout Designer.
Bl Zooms out of the preview in Layout Designer.
pl Sets the view/window size back to its normal size

:@ Toggles the raster that objects can be magnetically aligned on

Zoom and camera pans can be set in Layout Designer by defining movement marks. You can find
the necessary buttons in the toolbar of the Layout Designer. They will be explained in the respective
chapters.

At the bottom edge you can find the navigation controls for replay in Layout Designer.

> lo @ [l B ¥ w4 | o0:00.000 |

EI Replays the slideshow from the beginning.

‘B Replays the slideshow from the selected object.

The navigation bar changes after the start of the replay.
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il B les @ o o9 | 00:12.599

m Pauses the replay.

Ends the replay.

If you pause the replay additional navigation options become available.

> @ ke W o wf | o0:06.900

[:il Continues with the slideshow.

I‘ll Jumps to the previous object.

H_I Jumps to the previous single picture. This way it is possible to carefully check separate
sequences.

il Jumps to the next single picture. This way it is possible to carefully check separate
sequences.

'il Jumps to the next object.

There are two distinct areas in Layout Designer - the visible and the invisible area.

Layout designer

fslek | PP @IE'H?@ & U T Time mark: :lf_l.rl.:l.lflSEC :E

...............................................................................

> b ke o o | 00:00000
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The visible area represents your monitor. Everything inside this area will be displayed later on the
monitor. The invisible area is outside the visible area. We need it to be able to let text, images and
other objects fly into the visible area. It means that movements can already take place outside of the
visible area and then continue to move into the visible area. This way you can for instance let text
run from left to right over the screen. The magnifier icons can be used to increase or decrease the
size of the visible area.

The Object settings

Each Slideshow object (image, chapter, collages, ...) has certain properties that will be displayed
when you select the object in Image list, Timeline or Storyboard. In the following graphic you see the
settings for an image. Objects and their properties will be explained in more detail later in this
documentation.

Object settings o3 x
|| Show obiect
Duration: (11,00 sec 3 | Distance: |0,00 sec o

Image T Text lil]] Sound % Transparency

DO T P
Data'Peach.jpg £
=I Transition
Fade in: Random v
Fade out: Leave in place (do not hide)
Fill: an v 1
Fill colar: N -
=l Position
Aspect ratio: Keep L
Alignment: ‘@ Center -

Rotate in direction of movement

You can specify the duration of your image and its transition, for example. On the Text-tab you can
add and format text. And on the Sound-tab you have the option to assign a special comment or
sound to your image.

The Toolbox

The Toolbox is the place where you find all the objects that can be added to a slideshow. You can
click on them and drag them with held-down mouse button to position in the Image list. This
process is called drag&drop. By double-clicking an object it will be added at the end of the show.
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| Image effects | Text effects | Movement paths |
J Slideshow objects ‘ Fade-ins | Fade-outs |
1
= Default = E
| L Ema
[E5|
L‘:‘LI
Image Text Video Sound Chapter
Feggl 77
W
e
Ll - e
Flexi-Collage Partide  Placeholder -

When you click on the Transitions-tab in the Toolbox you find a large selection of pre-defined
transition effects. Click on a transition and you will get a small preview of the effect. If you want to
assign a transition to an image drag it with held-down mouse button to the image (drag&drop).

| Image effects | Text effects | Movement paths |
| Slideshow objects | Fade-ins Fade-outs

B Default ———————— 5

Mone Random Alphablending Bouncing

Color fading Grow Push away Slide

The Timeline

The Timeline displays the temporal flow of your slideshow and all its images, texts and musical
scores. By using Chapters you can create multiple tracks. Images and sounds can be spread over
these tracks inside the Chapter. You can find it in the Tool/box on the tab Slideshow objects.
Here you learn how to create multiple tracks.

- Click hiere to add: hackgfowsd MLEIC
iate: ﬂmmnslctmd( mma ins emptyaslong as the s[’deshnwdaesn lc{:nlamaw images.
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There are two sliders in the bottom-right corner that allow to change the size of the time display and
the height of the objects.

The Storyboard

Here you can switch to the Storyboard. It shows a small preview, called thumbnail, of all images in
the show. This makes it easier to find a certain image in case your show grew rather large. Here too
you can change the order of the images by moving them with the mouse.

Imagelist

Use the slider in the bottom-right corner to specify the size of the thumbnails.

The Image list

All objects of your current slideshow are displayed in the Image list. In addition, further useful
information about the objects are displayed as well.

Copyright © AquaSoft GmbH 1999-2015



First steps 11

Imagelist o3 x
Object Start time  Duration File size  File date  Settings  Track Keywords EXIF File name Caphure date
2w 3 1. Chapter 0,0sec  37,5...
v @ 1. altpapier bg_... 0,0sec 1,0sec 313.... 02.07... 1 v datala...
¥ T 2 Imageeffecti... 1,0sec  6,0sec Ty
¥ T 3 vintagephoto... B8,0sec  6,0sec T g
=+ W 3 4. sepia photo 14,0sec  23,5...
¥ @ 1 shuttersto... 14,0sec  14,5... 64,665 02.07... % 1 datals...
¥ [ ] 2 Placeholder  28,5sec  1,0sec
¥ ] 3. shuttersto... 29,5sec 7,5sec  64.665 02.07.. % datals...
¥ [ ] 4. Placeholder  37,0sec  0,5sec
v T 5. original 150sec  13,5... Tag 2
v| b 6. shuttersto,.. 29,5sec  7,5sec 55672 02.07. datals...
¥ ] 7 shuttersto... 17,0sec  11,5... 64,665 02.07... % 3 datals...
¥ @ 8 shuttersto... 29,5sec  7,5sec  102... 02.07.. '%I datals...
¥ T 9. Colorizing: ... 18,0sec 10,5... Ty 4
¥ @ 10, shutterst.,, 20,0sec  8,5sec 64,665 02.07.. 5 datals...
¥ T 1L Colorizing... 21,0sec  7,5sec Ty 3
- v 3 2. cross photo 37,5sec 32,0..
B v I 3. Puzzle 1:09.5... 32,0...
& ) 3 4. Graphic 1:41.5... 32,0...
B v H 5. Optimization + Ob... 2:;13.5... 27.0...

Here you can see the start time and duration of the objects. For images there is an entry for file size,
file date and file name. Under Extras -> Program settings -> Image list you can select the
columns that you want to be displayed.

A check mark in the EX/F column means that the image contains EXIF data (e.g. exposure date,
camera model and image resolution). These can be displayed in AquaSoft ® SlideShow. More
information about this can be found in chapter variables.

Another important column is Track. It shows in which track of the Timeline your object is located.
If this entry is empty then your object is in the first track. But you can create multiple tracks inside a
chapter, and the column Track informs you about the object's track number. Of course you can also
see this in a graphical way inside the Timeline.

You can change the order of the images by moving them with the mouse.

Copyright © AquaSoft GmbH 1999-2015



12 AquaSoft SlideShow - Help

1.3 The Timeline

In the Timeline you see the chronological sequence of your show. It informs you when an object
will be replayed.

0 oz

@Jﬁrﬁhﬁrﬁhﬂrﬁm

Images, text, collages and videos can have different ways to present them. So can images get camera
pans, movement paths, transitions and text. The Timeline shows you what kind of animation an
object has been assigned.

There are:

Transition

Text without animation
Text with animation
Image effect

Movement path

BEEEEE

Camera pan

You can also see the file name and duration in the Timeline. The sliders in the bottom-right corner
allow you to adjust how much you wish to see.

By clicking the E icon the context menu for the object will open. You can use a right-click on the
object instead to achieve the same.
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K Cut

M Copy
M Remove
[B Paste

Object settings

]

Caption

Edit image
Einblendung wihlen
Ausblendung wihlen
Select text animation

Record sound

Edit zoom & camera pan

TS e FEHE N

Edit movemnent path

During the replay of a slideshow in Layout Designer a blue line in the Timeline marks the current
replay position.

0 oz

| @ 4 @ 4 @ 4 @

This line "runs" with the show. You can move it after you paused the show.

You can change additional settings for the Timeline under Extras -> Program settings ->
Timeline.
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Program settings

[z Main settings
Plug-ins
Add files
User interface
Temporary folder
Language
Automatic update
Record sound
Default image settings
Confirmations
Sound system
CD/DVD BD-Burner
Automatic backup
= Panels
Storyboard
= Layout designer
= Grid
Object grid
Center lines
Regular
Default
Imagelist

Timeline

+'| Show hints

v’ Show hundreths of a second

Style: Rounded v
Edit
| Use other objects as snap guide +|Use time raster
Snap distance: 10 * | pixels Time raster: 100 msec

oK Cancel

Help

Here you can specify the snapping behavior and the look of the Timeline.

If you want to position an object exactly below another object or at a certain point in time the
snapping option can be very helpful.

If you deactivated an image of your show (Show object deactivated), it will
! not be displayed anymore in the Timeline. The Timeline displays only
', objects that are supposed to be replayed. If you want to reactivate an image
you can do this in the Image list or in the Storyboard.

2 Design options in AquaSoft ® SlideShow

We recommend to first read the section First steps with AquaSoft © SlideShow prior to the following
tutorials. There you will receive an insight into the basic functions of the program.

In the Program overview section the working environment of AquaSoft ® SlideShow is explained to

you.
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2.1 16:9 or 4:37?

At first you have to specify the aspect ratio you want to create your slideshow in. The aspect ratio
defines the ratio between image width and image height.

Welcome to SlideShow Ultimate @

Recently opened slideshows:

Show dialeg at start

If you want to show your slideshow on TV later the aspect ratios of 4:3 and 16:9 come in handy.
Older CRT-TVs only support the ratio of 4:3, while modern flat-panel TVs support both 4:3 and 16:9.

EEEEEEEEEEEEEEEEEEE

4:3

16:9

assmsssssssmsnnenenmnnnnn

SUSEEEEEEmEmE
EEEEEEEEEEEER
JSEEEEEEEEEEEER
EEEEEEEEEEEEED

If your images are in format 4:3 or 3:2 (digital single-lens reflex cameras) select 4:3 as aspect ratio.
If they are in 16:9 format select this format respectively.

In case you want to use the format 16:9 even though your images don't have this format, the images
need to be adjusted into the 16:9 format. This is not possible without "cropping” the images a little

at the top and bottom. Without this cropping it is technically impossible to display a distortion-free
image.
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Layout designer o x

1552 DO O H- B | B % T - Timemark [0,005ec 8

D b [ | ¥ | 00:00.000

Initial state

Layout designer o x

1552 DO O H- B | B % T - Timemark [0,005ec 8

D b [ | ¥ el | 00:00.000

Adjusted by
"automatic" cropping

Layout designer o x

1552 DO O H- B | B % T - Timemark [0,005ec 8

D b [ | ¥ el | 00:00.000

Adjusted by
"automatic" stretching

What do you have to do now?

Insert an image into an empty 16:9 slideshow.
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Layout designer

(i PP HE- B %% E - Tmemark 000sec 2 [H

> b [le [ ol o8 | co:00.000

You see the black borders left and right of the image.

Decrease the size of the visible area in Layout Designer by clicking on the —, icon. Now increase
the size of the image by dragging the handles at the corners of the position frame until the black
borders disappear. At last position the desired area of the image in the visible area.

Now it should look similar to the next graphic:
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Layout designer orx
J:k |!‘~%§;—HEBD|E'H§!$|%%' Time mark: E,Bﬂsec :JE

:?,-
B> ko |ke ko o oef | 00:00.000

You can save this positioning to a template so that you don't have to repeat this process for every
single image. To do this simply drag the image from the Image list to the Toolbox and specify a
name for the template in the now opening dialog.

Name: Template 15_3 -

Title: |Temp|ate 16:9 |

Author: | |

Activate all objects whose file names should be adjusted when using the template.

Object
<« [¥] @] 1. shutterstock_21842593.jpg

After clicking OK you can find the template in the Toolbox under Slideshow objects -> Custom
objects.
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File browser

Image effects Text effects Movement paths
Slideshow objects Fade-ins Fade-outs

= Controlling ——

Lijid

Pause Flay
E Custom objects ——
A

Template
16:9 -

Filter b =) ———

To add additional images in 16:9 format, simply drag the saved template with pressed mouse button
onto the Timeline or the Image list. The dialog to add images appears. Now select the images you
want to add, and they will be inserted with the settings of your custom template.

2.2 Adding images

In AquaSoft ® SlideShow you can add your images in various ways. Some of them are very intuitive
to use, while others are more advanced. Learn in this chapter the methods for insert images and find
the solution that suits your needs.

About the Plus-symbol

I::-|:,-|:l In the Toolbar at the top of the user interface is a large P/us-symbol. Clicking the symbol

J will open a view of your folders and locations. Select the place where there are one or more
images that you want to insert. Select the image or images (5trg-key and click on the image
to select multiple images) and confirm with OK.

About the Toolbox

Select the SlideShow objects Tab in the Toolbox. In the section Default you will find
the Image object. Add it either by double-clicking or drag it with the mouse in the
Timeline or Image list to the point where you want to insert an image. It is also
possible to drag the Image object on the Layout designer.

.
‘, #

Image  After the Image object is placed, the Add files dialog opens again. To select one or more
images you can do the same as it was already described in the top section.
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About the Filebrowser
™ - D Display the File browser. It is located on the left in the

o Cmpiens R bk 3 Do ke ‘| Default view, where the Toolbox is displayed initially.

Computer

£, 0s(c) T Open the folder where your images are located. Sometimes
: g | you have to open the folder structure further to see

< ] subfolders. Just click on the little plus icon, which is

i B it located in front of the folders.

The images are displayed as small thumbnails in the File
browser. You can now drag these preview images to the
Layout Designer, the Timeline or the Image list.

Per Drag & Drop

If you open a folder where your images are located outside of <%¥COMPANYPROGNAME_R> you
can drag the images into the program window of AquaSoft ® SlideShow.

Minimize the program window by pressing the Windows key and the down arrow on your keyboard (or
click the symbol on the top right of the window to minimize). Now you can easily drag files from a
folder or from your desktop to the program.

About "Add"

In the top menu bar, there is the Add item, in which you get several

-+ . . . .
L Images options for inserting various types of data.
%) Sounds If you select the Images option the Add files dialog opens and you can
Bl Videos select one or more images.
" Background music With the Directory option you can insert an entire folder. If you select
= this option, a dialog box appears in which you can define exactly which
Any file data will be inserted, and whether to include subfolders.
!f_," Directory
Import k

Using the Import Wizard

In the menu Wizards there is the Import Wizard. With this, you can insert images directly from a
camera or scanner into the show. See chapter "Import Wizard" for a detailed description.

Using the PowerPoint Wizard

If you have a PowerPoint presentation and want to transfer the slides in your slideshow, then follow
the instructions in chapter "PowerPoint Wizard".

2.3 Transitions

o )=
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Each image in AquaSoft ® SlideShow can get a transition assigned. This can be done by changing
the settings in the Object settings window, but also via the Toolbox.

il

You can add several images at once by selecting them in the file selection dialog. Press
the Ctrl-key and click on the images you want to add.

Add an image to an empty slideshow. To do this use the —-button in the menu bar.

In the Toolbox you find the Fade-ins-tab. When you click on a transition you will get a small
preview.

| Image effects I Text effects I Movement paths |
| Slideshow objects | Fade-ins Fade-outs |
= Default

>

Alphablending Bouncing

BT

Color fading Grow Push away

Using Drag&Drop (moving with the mouse) you can now assign a transition to an image. Click the
transition with the left mouse button and hold it down. Move the transition to the target image in the
Timeline. Release the button when a red border appears around the image.
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Image effects

Text effects

Slideshow objects

El Default

g 3

Color fading Grow

B

Paper iinds

Fade-ins

Push away

Fade-outs

| »

Click on the image and then on

All images = Ctrl + A

Certain images = Ctrl + right click on the image

b

If you would like to assign a Transition to several or all images select these images.

to play the image with the transition.

Select the Transition with the left mouse key, then click right and select Apply. The Transition
will be assigned to all selected images.
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Image effects Text effects |

| Slideshow objects | Fade-ins Fade-outs

El Default

Color fading Grow Push away

Cube a Increase icon size ire

EI Shapes —————— Decrease icon size .
2 Tabs left D \

! ﬂ v Tabsontop /) -

m Tabs right

Tabs at the bottom

You can see the specified transition in the Object properties of the image. There you can also
change it and even customize it. The following text will give a more extensive description.

If you click on an image in the Timeline with the right mouse button or click the E ico a pop-up
menu will provide you with the option to select a transition.
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Cut
Copy
Remove

Paste

oo x|

Object settings

—]

Caption

Edit image

Select fade-in

Select fade-gut
Select text animation
Record sound

Edit zoom & camera pan

Edit movement path

EER R

About the Object settings

Every object in a slideshow has a set of so called Object settings. For example, you can set the
Duration, specify a Transition and enter Text. Right now we only want to talk about the
Transition. Here. you can find more about Object settings.

Click on an image in the Image list or Timeline.

If you don't see Object settings in your current view you can open it by right-clicking
! on the image. Alternatively you can reach the Object settings under View ->
e, Controls.

The transition is set on the Image-tab in the Object settings.
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Object settings oL x

Duration: (11,00 sec 5 | Distance: [0,00sec 3|

i Image ! T Text | iIl] Sound | *%! Transparency
DO L P
i=I File name

Paiﬁ\,ﬁeam .ipa =3

\=I Transition

Fade in: | Random = | ||

Fade out: | Leave in place {do not hide) - | !
= Background -

Fill: !ﬂ'l_ -~ |8

Fill color: .

= Position

Aspect ratio: !Keep - |
Alignment: E_ﬁ__faenter - |

| |Rotate in direction of movement

In the transition list you can see all pre-defined transitions and select one. Each transition is
customizable after clicking on Adjust.

5B Transitions

| Fade in | Fade out |

| Paper blinds bt |

oK | | Cancel
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24

If you want to change the transition for several images at once just select these image in
the Image list and set the desired Transition in the Object settings. It will be assigned
to all selected images.

Via Ctrl+A you can select all objects in the image list. With the held down Ctrl/-key and
mouse clicks you can select several single images.

Text animations

Of course a slideshow should also have text, and it shouldn't be just simply displayed but it should
be possible to animate it.

In AquaSoft ® SlideShow you can enter text to an image or display it on a colored background.
Texts also can fly over the image along freely definable movement paths.

241

Text to images

Inthe Object settings of an image there is a Text -tab. The Object settings will be displayed
when you select an image in the Image list/Storyboard/Timeline with a mouse-click.

If you don't see Object settings in your current view you can open it with a right-click

Controls.

ld‘ on the image. Alternatively you can reach the Object settings under View ->
L
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|Dbject settings

[#] Show object

- -

Duration: 3,00 sec 2 | Distance: (0,00 sec 2 |

[T Use default duration {Settings)
[#] Leave in place after replay

=l Fonk

[#] aridl  AbCoEfGh - - [

[=] Style Alignment

AA =B=-==FC

=] Text

[= Effect

A 3D € Border color: | -
Animation;
éf._lphablendin_g_ b | | ];e.- Edit |

- Rotation around ket _ Show ket with image
center -

Behavior along a movement path:
;Text block, T |

Here you can enter text to an image and assign formatting like font, font size and font color.

The available formatting options are almost self-explanatory due to their icons, and you probably
know them already from word processing applications.

The Alignment has a small peculiarity, however.

@ Positions the text at the lower edge of the screen.
[%] The text will be displayed in the center of the screen.
@ Positions the text at the upper edge of the screen.

Detaches the text to be able to customize its position.

[;] The text will be displayed underneath the image. This also applies when the image is scaled
smaller.

Enter the desired image caption into the text field. Specify font and font size. If you want colored text
you can change the font color. Select the position of the text. If you want a customized text position
click the II —-button under Alignment. All changes are immediately visible in Layout Designer.
In the customized position the text gets its own position frame. This way you can freely place the
text anywhere on the screen.
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¢ | Obiect Settings

Duration: ‘500

Arial

Object settings
[#] Show object

sec

BOCOETGH] w B v

I ES_!:_yle Alignment —
Ba =E=_--E=
=l Text
Mustangs
[t
i ‘
|| =l Effect
- ey || ASD S Eorder colar:
: Animation:
El_phablendlng_ % | | Th dit =|
— Rotation around text _ Show text with image
" center ]

Behavior along

e | B

a movement path:

In AquaSoft ® SlideShow you can decide if you want the text to be separately animated or to be

part of the transition effect of the image it accompanies .

[=I Effect

A 3]} S Border color:
Animarion:

Alphablending v | | T die |

If you don't want a separate text animation please activate the option Show text with image.

For text that you want to be animated you can choose from a list of pr
the Edit-button to adjust the settings for the animation. You can also
in this dialog.

e-defined animations. Click
see a preview of the animation
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Textanimation bearbeiten

Animation: |A|phablending - gedndert L=

Einblendung | Ausblendung

Effekt: |Zoomer ¥

Zeichen gleichzeitig: (9999 =
Schriftbreite: _D— 100%

Schrifinghe: A % Mustangs

Rotationsanzahl: 0 s

Rotationszentrum: |Bud15tabenzentrum - |

[] Zufallige Reihenfolge [#] Alphablending aktivieren

[ Bewegung [] Drehe in Bewegungsrichtung

Beispieltext:

[Mustangs

= Modulation

b oK ]| |f Abbrechen

You can also open this dialog by clicking on an image in the Image listor Timeline

1 and then on Select text animation.

Under Fade out you can specify if you want the text to stay visible until the end of the image
duration and to be included into the transition to the next image or if the text fades out at the end of
the image. The duration of the animation specifies when the fade-out is to be started.

If you set 3 seconds then the fade-out starts 3 seconds before the end of the image display.

H

By clicking the —I -button you can save the text effect settings you just selected. They will then be
stored in the Toolbox under Text effects and can be reused at any time. Saving text effects is only
possible with AquaSoft SlideShow Ultimate.

After you finished all the adjustments you can then replay the image together with the text by

I

clicking on

You can find all pre-defined Text effects in the Tool/box as well. You can use these simply by
Drag&Drop, i.e. by dragging them with pressed mouse button to an image.

Select a Text effect and you will see a preview of it.
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Drive in From right  Drive through {single, Crive through (single,

-

Drunken rise
(centered)

left ta right right ta left)

Mote:the musictrack remai

As described above, you can enter and format text on the Text-tab in the Object settings.

242

Text without an image

Inthe Toolbox under Slideshow objects there is the Colored background. With this you can
fade in text independently of images. The Colored background can even be faded in animated.

To insert it, double-click the Colored background or drag the object into the Image list or onto
the Timeline with the mouse button pressed down.

When inserting it with the mouse button pressed down, you can also determine the desired
position on the Timeline and in the Image list. Should you wish to add the Colored
background between two images, drag the object to the desired place with the mouse. A
red line will appear between the two images. Release the mouse key to insert the object at
this position. This is also possible in the Image list.
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mlﬂx

Slideshow ohjects
[= Defaulk - i
Chapter Collage Image Particle Placeholder Sound Text Videno
Colared Pause Play ‘White,
backgroun transparent -

i = Click heretoadd béckg'r'pgn'd'm,usic' .
Mote: the musictrack remains empty aslong as the slideshow doesn'tcantain

The Colored background is shown on the Timeline as a black image. In the Image listitis listed
as blackixl.gif.

The text can now be entered as with a normal image.

On the Timeline, click the object with the right mouse button and select Select text animation.
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K Cut
M Copy
M Remove
[B Paste

Object settings

]

Capticn

Edit image

Select fade-in

Select fade-out
Select text animation

Record sound

Edit zoom & camera pan

TS v F EHEN

Edit movemnent path

Now the Select text animation window opens. There you can enter the desired text and select and

edit a corresponding animation.

Textanimation bearbeiten

Animation: |Diagonaler Durchflug unten rechts (eng) - geandert

Einblendung | ausblendung

Effekt: |Zoomer - |

Dauer: 2,508 =

Buchstabenposition beriicksichtigen

Startposition: |unten rechts -
0% =

A = 5 =

[+ Modulation

Schrifthéhe: _D— 100%
'

Rotationsanzahl: k- &

Rotationszentrum: |red'|ix h |

[] Zufallige Reihenfolge [#] Alphablending aktivieren
Bewegung [] Drehe in Bewegungsrichtung

Under Fade out you can determine whether the text should remain visible until the end of the image
and should be cross faded with the next image, or whether the text should be faded out prior to the
end of the image. In this respect, the duration of the animation determines when the fading out

should begin.
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Should you set 3 seconds, the fading out is started 3 seconds before the image finishes.

I> |
With OK your entries are accepted and you can use

screen.

to play back the text animation on the

The background is now shown in black. If you wish to have a different color, you can do this in the
Object settings of the Colored background. For that purpose, you have to click the object in the

Image list oronthe Timeline. Should the Object settings not be shown in the view available to
you, you can also retrieve them by right-clicking the object.

Object settings

Object settings

|| Show obiect

Duration: llrﬂlfl sec 2| Distance: DDD sec

-

POV oL T

= File name
Data\Peach.jpg
Fade in: | Random

Fade out: Leave in place (do not hide)
= Background
Fill: lon b 1

Fill calor: I- o

= Position

Aspect ratio: .Keep
Alignment: | I Center

' | Rotate in direction of movement

88

i
-

Image lT Text ‘]]] Sound '% Transparency

1 x

)

By clicking the selected button you can change the background color.

You can also have the colored background faded in animated. Under Transitions you can select a

cross fading effect.

Under Text you can carry out the formatting of the text, as well as change the color of the font.
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Object Settings

|Dbject settings

: [#] Show object
Duration: EI_D_,DD sEC :_l
[T Use default duration {Settings)
[#] Leave in place after replay
[=/ Font
drial ABCHEIGHI - -
[=] Style Alignment
A ERFE—==Ec
=] Text
[= Effect
A D S Border color:
Anirnation:
alphablending -] o Tckde g
—Reotation around text |!i___; Show ket with imagel
I canter i
7 & maovemen

Should the text not be faded in animated, but together with the colored background, check the Show
text with image option.

The Colored background can also be used to dim out/fade out images. Should a
black background color be set and a cross fading effect selected, it has the effect on the

observer of a fading out of the previous image. In this way you can end a slideshow in
style.

2.4.3 Rotating text

Adding texts to images or a colored background has been described in previous chapters. This
chapter is about their rotation functionality.

This feature is only available in AquaSoft ® SlideShow Ultimate.
|i
\.ﬁ

First add a text to an image. This should look similar to the following graphic in Layout Designer.

Copyright © AquaSoft GmbH 1999-2015



Design options in AquaSoft ® SlideShow 35

ayout Designer

'?{\ '::“{\ E}Q-IE‘I.%I@ I%%I | Tirne mark: |0 sec > iE

Please note the green handle above the text. You can use it to rotate the text. Click the handle, hold
down the mouse button and move the mouse in a rotating motion.

ayout Designer

G Oﬁl@h%“f? E%;'ﬁ;iiTimemark: isec 2 WE

The number next to the green handle shows by how many degrees the text has been rotated.

You can find more information about the use of rotated text in chapter Letting texts fly.
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2.4.4 Multiple texts

In AquaSoft ® SlideShow there is also the possibility of fading in multiple texts either simultaneously or
with a time delay.

In the Toolbox there is the text object for this purpose.

| Image effects i Text effects | Movement paths |
Slideshow objects Fade-inz | Fade-outs |
B Default ———————— &
Emal
P 1 ] B
H B
[
Image Text Video Sound Chapter
r E‘l 7
]
™ -
L=
Flexi-Collage Partide  Placeholder -

Fading in multiple texts, in sequence
In this example 3 texts to an image appear, in sequence. The number of possible texts is not limited.

Insert an image. Using the Tool/box, now add 3 Text objects. You can do this with a double-click or
by means of drag-and-drop (dragging with the mouse) into the Image list or onto the Timeline.

Imagelist =R X

! Object Starttime Duration |

| W @& 1.img_193070.. 0,0sec  S0sec |
e WT 2, Text 1 S,0sec  5,0sec
o WOT 3. Text 2 10,0sec  5,0sec
LW T 4 Text3 15,0sec  5,0sec

Now select the first Text object. In that respect, it does not matter whether you click it in the Image
list oronthe Timeline.

Inthe Object settings of the Text object, you can now enter your desired text and carry out the
formatting. Position the text in the Layout Designer.
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Layout Designer

Obj
[¥]Show object

Duration: (5.00 sec )

[¥] Use deFault duration {Settings
[¥|Leave in place after replay

T

(= Font
avial ABCUETGH] - =
= Sty_rl_e_ Alignment

B =E=l_--E

= Text

Text 1

=l Effect

A D S Border colar: @]

Animation:

|Cha0tlc turnin g | I; '];k Edit 1I

— Rotation around kext
[ center

Behavior along a movement path;
Texk black: z

I R L LR A

Select an animation and then call the editing function of the text effect via Edit.

So that the text is not faded out again before the next text is shown, the No fade out option must be
set under Fade out.

Animation: [Chauﬁmes Eindrehen - gesndert

-Enblendung Ausblendung

Effekt: |Keine Animation -

Ein- und Ausblendung abspielen
Beispieltext: .
www . aguasoft.de

You can also have the text faded out if it is no longer supposed to be visible when the subsequent
text is displayed.

Now repeat the steps with the second and third Text object.

Copyright © AquaSoft GmbH 1999-2015



38 AquaSoft SlideShow - Help

Layout Designer

e

& "}{\E,%ff‘ c%;% Tirme mark: [0 sec ol =

|

Then play back the little show with —I .

Inthe Object settings of the Text objects you can change the holding time of the texts.

Object Setfings

EDhject settings

| ®Ishe

[¥] use
|¥|Leave in place after replay

Dration: iS,DD SEC :—!

i object

default duration {Settings)

| ik TEXL‘] iy Transpatency
= Fonk
aridl  ARCOEIGH] v 26 v

ES..':‘."IE Alignment —

AA B==(===
=l Text

Text 1
= Effect

A SD S Border color;
Animation:

[chactic turn in ~ | e Toc Bt
_ Rotation around text

Ucenter

Showing multiple texts simultaneously

In order to now not show the texts in sequence, but simultaneously, the Chapter object is required.
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Use the little show that you have just created.

Image effects | Text effects | Movement paths |
Slideshow ohjects ' Fade-ins | Fade-outs |
= Default = ot
" Eas] O
A ]
)
Image Text Video Sound Chapter
r E‘I Y
- m
.- -
L -+
Flexi-Collage  Partide  Placeholder -

Add the Chapter object into your show.

| Obect
V& 1.img 193070,
v T 2.Textt
VT aTextz
VT 4Texs
¥ 8 5. Chapter

Timeline

1
|, am i|'|l

The Chapter can have several tracks and therefore show the Slideshow objects in parallel/
simultaneously.

Timeline
Timeline [0

] ;
|; Om i|'|l :

Click on the image on the Timeline and drag it with the mouse button pressed down to the
Chapter object. The Chapteris framed in red if you go over it with the mouse. If this red frame
appears, "drop" the image.

After that it looks like this on the Timeline. You now have to open the Chapter. There is a little
plus symbol for that.
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Now drag the first Text object into the Chapter. Drag it to underneath the image in the Chapter.
A red vertical bar will appear if you move the mouse to the correct position.

If you now drag the Timeline to make it larger, it must look like in the illustration.

> |

Now play back the show again with
simultaneously.

. You will see that the image and the texts are all faded in

Using the Timeline you can adapt the timing individually. For this, you can simply drag the Text
objects with the mouse into the starting position.
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When you don't work on a chapter you can close it by clicking the minus symbol.

2.45 Letting texts fly

The Text objects which you have already become acquainted with in the previous section can also be
animated with a movement path. In other words, they can "fly" across the image.

For this purpose, the Layout Designer provides the necessary tools.

Insert an Image and a Text object into your show.

Obiject Start time  Churation
oo 1, img 193070, 0,0sec  5,0sec
W T 2. Text 1 5,0sec  5,0sec

Timeline

Then click the Text in the Image list oronthe Timeline.In the Layout Designer the tools for the
movement path are now enabled.
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Layout Designer

This is the icon for switching, in the Layout Designer, into the mode for
%, movement paths. There is yet another mode for camera pans and zoom.
_l Since this function is not available with the Text object, the icon for the
movement path mode is active.

Use this button to insert new movement marks. The course of the
movement is established on the basis of these marks.

| &7

In order to remove movement marks that have been set, the latter must
be selected in the Layout Designer and can then be removed with this
button.

|

In this respect, an additional menu for the movement marks is opened.
This is explained more precisely later on.

@

The chronological course of a path is established with timestamps. They

Tirne rnark: |2_.§sec :_il thereby determine how quickly the sequence should occur. That is clarified
“ in an example below.

Newly created movement paths can be saved using this button and later

El conveniently reused. This function is only available in SlideShow
Ultimate.

Inserting a movement mark
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Layout Designer

GG TGS | £ |.%I¢? I% | | Time marks (2 sec 2 ||

el

Insert a movement mark by clicking

Positioning a movement mark

Layout Designer

OO O | | |

43

You can now drag the movement mark inserted in the Layout Designer. For that purpose you
have to click in the text area and then drag the latter with the mouse button pressed down.

The orange dot shows you which movement mark has been selected.

Now you can replay the show by clicking

and watch how the text moves.
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Chronological sequence

Layout Designer

!

0, 2, 8, 5 A | B35 B [rmem e | 2
=== l ————— []

With Time mark you can control the sequence. If you increase the time, the sequence becomes
slower. If you reduce the time, the sequence becomes faster.

First increase the Time mark of the movement point and then replay the show.

Starting time

Layout Designer

@3

.3 O 5 %85, [ | B
=== l ————— ]

If the movement sequence is only supposed to begin after a time delay, you can increase the Time
mark with the first movement mark. For that purpose, click the movement mark and then
increase the time unit. The subsequent movement marks will automatically be adapted.
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Inserting additional movement marks

You can insert as many Movement marks as you like. The new movement mark is always
inserted after the previously selected mark.

Layout Designer

NG G R : £ Ingplx““ % : | Tirne miark: |8 sec : E
B =——— l ————— ]

w
Select the last movement mark and with J insert a new mark and position it in the Layout
Designer.

Play back the show. You will find that the last part of the movement path elapses faster than the
first part. You can control this for the 3rd movement mark via the Time mark.

Hard and soft curves

In the course of movement you can choose between hard and soft curves. With Hard curves the
path will run exactly in accordance with the movement marks. With Soft curves a round course of
movement will take place. You can use both curve types within one path.
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Layout Designer | ox

R "%E Ingplx““ % % | Tirne mark: |8 sec : E

el

Copy path
Inzert path
Position frame 3

Curve type »

Transform path

Custorm entry..,

Select all marks

Select a movement mark. Using the right mouse button you will get the menu for this movement
mark and can change the Curve type there.

Change the Curve type for all 3 marks.

Layout Designer

R "%E Ingplx““ % % | Tirne mark: |8 sec : E

el

You will see that the movement marks now have a rectangular marking point. Selecting Soft
curves these points become round.

In order to see the change in the path, play back the show.

Rotating text during movement sequence
In SlideShow Ultimate you can rotate or swing texts during a movements sequence also.

For this purpose there is a green handle above the Text field. More extensive information about the
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rotation functionality for Text you can find here.

Layout Designer

First rotate the text at the first and second movement marks. Rotations through 360 degrees are also
possible, to create complete rotation.

Layout Designer

Play back the show. You will see that the rotation center is, in this respect, the midpoint of the text
box. Should the rotation center be the center of the text, enable the Rotation around text center
function in the Text properties.
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frisl  ABCHEfGh] + 26w

[z Style Alignment

DA B==|-==3

| = Text

[Text 1

| = Effect
A an S Border colar: [E]

Anirnation:
|Chantic burn in * | e T it

|| - Rotation around text
|2 center

Behavior of text along a movement path
There is another option for text moving along a path.

| = Font

frisl  ARCUEfGHj + 26w
;E!:yle Alignment

BA B==_--F
| = Text

[Text 1

| =l Effect

: ASD S Border color: [E]

Anirnation:
|Chantic burn in * | e T it g

— Rotation around text
Ml eenter

| [Behavior along a movement path:

T |

[Text block

Use it to let text "snuggle up" to the path as text block or even character by character. The text will

rotate according to the path direction.

Letting the text fly in from outside
There are two areas in the Layout Designer. Firstly the visible area, and then the invisible area.
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Layout designer

s | P P @IE’I% & |0 s T Time mark: :If.I',D'Dsec :E

D: b | B B B8 | DO:00.000

gl Enlarges the visible area in the Layout Designer.
gl Reduces the visible area in the Layout Designer.

ﬁ;l Restores the normal view/window size.

Continue to use the show you just created. Reduce the visible area with —I in order to see the

invisible area in the Layout Designer.
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a signer =R I

=

T R R R

Now select the first movement mark and drag it into the invisible area.

e ——————
G '?ﬁi@ii%ifiﬁﬁiiﬂmemark: zsec I WE
W

o T | b b oo

Play back the show. The Text will now fly into the picture from the outside.

Zoom function for text
Just like rotation, this function is only available in SlideShow Ultimate.

Traveling along a movement path Text can increase and decrease in size. The smallest size is
defined by its specified font size.

Select the 2nd movement mark and increase the size of the position frame of the Text-field.
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e —
'?{\ '::“{\ E}Q-IE‘I.%I@ I%%I | Tirne mark: |6 sec > iE

L T
-

TR R

Play back the show. The Text will now fly into the picture from the outside.

Further options

Via J the context menu for the movement marks can be opened. With a right-click on a selected
movement mark, this menu can likewise be opened.

Layout Designer

Add movement mark

Delete movement marki(z)

Copy path
Insert path
Pasition frame 3
Cupve type r
Transform path »

Custorn entry..,

Select all marks

TR

Some options have already been used above. The following further options are available:

Copy path A movement path already created can be copied and thus re-
used with a slideshow object. If you copy a movement path
from a text object, this can also be inserted in the case of an
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| Insert path '

| Bosition frame

| Curve type

| Transform path

| TF‘- Custarm entry., i
| B | Selectall rmarks '

Manually editing the path

image.

With this option, you re-insert a copied path from the
clipboard.

If you want to be sure that the text or the image does not
change size in the course of your movement path, you can set
the Use the size from the previous one option here.

There are hard and soft curves with a movement path. The
course of a movement can thereby be modified.

A movement path can also be mirrored or rotated. You will find
the available options under this point.

A movement path can also be mirrored or rotated. You will find
the available options under this point.

With this all movement marks can be selected. Thereafter it is
possible to drag the movement path as a whole.

Manually entering the path enables the movement points to be positioned exactly.

Layout Designer - Custom entry

|Mark3 - §.00 sec

Center:

Width: 260

Height: 130

lFreer adjustable

“Fokbation:

angle: 0.0 B

“Edges:

Left: 54 Right: 314
Topi &7z [f4]  Eattom: 852
Curye bype: |Sm00th CUFveE ] |

[~] Relative input [~ | High accuracy

The Layout Designeris specified with a size of 1000x1000. The center of the image is therefore
500x500. Here you can directly specify the positions and sizes. You can also change between the

individual markers in this window.
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2.5 Multiple tracks

In AquaSoft ® SlideShow at first glance you only see an image and music track on the Timeline.
This serves to provide a better overview. At positions where you require multiple tracks, the Chapter

object is used.

With this you can connect as many tracks as you want. In that respect, it is not predetermined which
objects can contain a track. Therefore you can place images, music or texts on any track.

You will find the Chapter object in the Toolbox under Slideshow objects.

Image effects | Text effects | Movement paths |
Slideshow objects ' Fade-ins | Fade-outs |
B Default ——————— g
S Ens)] &
A )
[y |
Image Text Video Sound Chapter
Fadl 7o
-
L=l **#
Flexi-Collage  Partide  Placeholder -

The Chapter can be inserted by double-clicking. You can, however, also drag it to the desired
position on the Timeline orinthe Image list with the mouse button pressed down.

Insert a few images and a Chapter into an empty show.

The Chapteris inserted as an empty container. You will then have to move the desired objects into
the chapter. You can do that on the Timeline orin the Image list or Storyboard. Click on an image
and then drag it with the mouse button pressed down to the Chapter.

If you go over the Chapter with the mouse, the Chapteris framed in red on the Timeline. Let go of
the image there.

1
o2Emin

Tirnedire

Copyright © AquaSoft GmbH 1999-2015



54 AquaSoft SlideShow - Help

This shows that the objects are to be found in this Chapter. By clicking the Plus icon you can open
the Chapter.

Timeline 5

Underneath the Image object a hint regarding a new track is displayed. To add an image to the
second track you need to move it to this track.

Timeline

The red bar under the first image determines the starting position of the image. The image is
inserted at this point.

The reference to a new track now appears under the second image. You can place as many objects as
you wish on each track. In that respect, the red bar helps you to insert the objects in the correct
position.
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0015 min

You can also insert Slideshow objects intoa Chapter directly from the Tool/box. First of all drag
a Text object onto a new track.
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Slideshow objects (& ; nage effects effects ement paths
= Default -
Chapter Collage Image Particle Placeholder Sound Texk Yideo
Colored Pause Plav white,
background transparent -

imeline

Timeline [

EIJ:I_S min

Click heretoadd background music.
ains empty aslong as the slideshow doesn'tcontain

:-"ﬁote.'i:hemusictra’ck rem

Timeling

You can change the positions within the Chapter by dragging the objects with the mouse. By
clicking dragging the beginning and the end of an object, the Exposure time/Holding time of an
object can be changed.
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The objects within a chapter behaviour in a similar way to a pack of cards. In other
words, the object on the lowest track is arranged on top of the other objects. In this
example, the text is shown on all 3 images. Should the text stand on the first track, it
would be covered up by the images.

Example:

Often we are asked how Track/Sound is set for only a few images. The Background music should
be faded out at this point, but not interrupted.

Insert a few images into an empty show and a Chapter.

14
D0ZEmin

Then move the images into the Chapter. In that respect, the images should all be on one track.

Timeline &

Now drag a Sound object from the Toolbox onto the 2nd track in the Chapter in exactly the same
way as the Text object was inserted into the Chapter above.
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[= Defaulk

SULSY 708

Chapter Collage

Colared Pause Play
background

m| »

T &

Text Wideo

Image Patticle Placehioldg

Timeline

You

deshow doesn‘teontain

SYTUFFOFFRAT e FoCT[ [ 'F [EEFF FFF WPOTPErTp F-FIF I PYF-T FPRTrwTFIC

can add Background music by clicking the corresponding track in the Timeline. Using the

Plus icon, you can insert the track.
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- Slidesh N
2 S Background music |
hain settings
Slideshow flow ' 3

Transitions

Music settings

| 123 | @ [ £F | E - | Download GEMA- free music

ckaround music
Diescription 1 g‘ C:AJ sershPublichMusichSample Musichkaimba mp3 548
Loga

1]
E| SlideShow-Plaver El

" Standard Player [Directx)

Start pozition In 2ong 00sec =
End pesllion . {1 = il &)
Haltme Ll —
Start sona aftsl '

5 } it valles OF for orgstading).
-Start nest 2ong aftet 10z 2

E | oK ‘ | LCancel | | Help |

The title is then shown on the Background music track of the Timeline.

CERTCTFACRFRET® ] FCFT[ [ 'K FEE [ [FF Wrprpr ] K- FEF [ | BFF'T FOPT[ TIPIF|

The Object settings of the Sound object should be displayed in the Object settings window. If
not, select the Sound object on the Timeline by clicking it with the mouse.

Should the playback length of the sounds be too long for you, you can reduce it. The relevant
settings are marked in red in the illustration below.
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Ohbject Settings | R X
Object settings
[#] Show object

IDuratiDn: |25JEID 1= e I
Use default duration (Settings)

|l Sound

= Sound
O {MedisiMusic) Artisti01-Title01 wma @
|'= & Recard '|| Duration: 03:19,904

= ¥olume

Volume; 100 % %

[¥] Fade background music {Settings)
= Replay behavior

Start position:

() Adjust display duration to sound duration

) Continue sound after set duration
I 2 Fade sound after set duration I

Fade-out duration:

On the Timeline you will now see that the Sound fits in with the 5 images exactly. The
Background music is canceled during this period of time. If you insert yet more images behind the
chapter, you will see how the background music track is continued.

Ll = 4 G o e 0 ol o o 01 o i i

Images, texts and sounds can be combined in a chapter as desired.
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The Chapter has a Minus icon at the top on the left if it is open. You can close it by that means if
you are no longer working on this chapter. That increases the clarity in a substantial show.

jump to these chapters directly. SlideShow-Manager is already included in

By utilizing SlideShow-Manager you can create a menu for your show where you can
lgl SlideShow Ultimate. You can also add it as plug-in to SlideShow Premium.

2.6 Ken Burns Effect

ey &

You will find an example of the Ken Burns effect in the sample slideshows supplied with the
software.

In AquaSoft ® SlideShow you can quite simply apply this effect to your images.

Insert a few images into an empty slideshow. In the Too/box you will find the Ken Burns effect
under Movement paths.
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08

Search

Default  Storyboard Imagelist  Toolbox

Object Settings m B x I

Object settings
B
[#] show object

Durstion: [5.00sec 2

[¥] Use default duration (Settings

= .
‘ ) \J [¥|Leave in place after replay
e Y o AT

Delet b Expl Ken B T -
el Emnhvemen wplosion en Burns (in 1) ;D G ‘ e E@g 49 =

Q (/ ) =l File name

( \ ‘ jeffensme: |
- = a 0:\Media|Imagesiimg_4372440.jog 3
a a a 3 = Transition L

KenBurns (in 2) Ken Burns (in 3) Ken Burns (in 4)

G
Output

B =

Save | Add | Music  Settings

i

New  Open..

[=NR. 4

BN YT —

|Random transit - ‘ ‘. (i Adiust |‘

1 =y (= Background
0 ¢ ) ijoq i“"%/i ®

Fill color:
| | o | b v od

W o0 A @ @ M 2% & on @ W gy 3 &2 33 @ i om @ s oM

Click here toadd backaraund music
Mate: the musictrack remains empty aslong as the slideshous doesn‘trontain any images

cac22%2%c"

|
Delete Explosion  Ken Burns {in Ken Burns {in Ken Burns {in |
movemnent ] 1 3 _

248Ac A S

R Ken Burns {in Ken Burns {outken Burns {outken Burns {out
5 1) 2) 3) b

s , i
Mote:the musictrack remain

If you would like to assign a Ken Burns effect to several or all images select these images.
All images = Ctrl + A
Certain images = Ctrl + right click on the image
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Select the Ken Burns effect with the left mouse key, then click right and select Apply. The Ken
Burns effect will be assigned to all selected images.

=l Maovement paths e
— \
/I
C 00 ol 03 03 0
Delete Explosion  kKen Burns {in Ken Burns {in Ken Burns (in

rovement

pﬁuﬁ

utken Burns {outken Burns {out

Increase icon size

Decrease icon size
Tabs left
Tabs on top
Tabs right
Tabs at the bottom

Note: the musictrack remain

Now select Alphablending as Transition inthe Image Object settings. The Fill function has to
be enabled as well.

Object Settings
Object settings

Show object

Duration: 5,00 sec 5

[¥] Use default duration (Settings)

Leave in place after replay

1 Sound | i Transpar

8@M%$ -

[=| File name

t\Ta_rinus)

[=| Transition

|.0.I|:|hablending - | |r Adjust |I
=} Background

Fill color: E

m

= Position
Aspect ratio: iKeep - |
Alignment: |" Center - |

Rotate in direction of movement
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Then play back the show with J .

You notice that the transitions could be a little smoother. This can be accomplished by using a
Chapter. Add a Chapter to the show. Move the Images into the Chapter and arrange the images in

a stair shape. The start of an image needs to be moved slightly underneath the end of the previous
one.

Then play back the show with —I .

The Ken Burns effect is implemented by means of a Camera pan. You can also change this
individually. For that purpose, you have to change in the Layout Designerto the Camera pan

mode. To do that, click J inthe Layout Designer.
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Layout Designer = '

:':‘;\{\ B Ol B Rl ke R S Time mark: |9 sec :@

. ﬁ) 0.0 zae

|
| g | e by ey

The movement path is now shown in the Layout Designer. How quickly or slowly a movement
progresses is determined by means of the time set to the 2nd movement mark. The greater the time,
the more slowly the movement is carried out.

In order to change the time and thus the sequence, click the 2nd movement mark in the Layout

Designer. The movement mark with 0.0 sec is the first one and therefore the starting position.
After you selected the 2nd mark you can change the time set via the image under Time mark. A
selected movement mark is shown in the Layout Designerin

When using a Ken Burns Effect only a part of the image section is used at the first movement mark.
You will notice the smaller Position frame. Only during the Camera pan will the full image section
become visible. Therefore, the Position frame is larger at the second movement mark.

You will find more about movement path in the chapters Movements and Zoom.

2.7 Adding videos

You can not only use images in AquaSoft ® SlideShow, but you can also insert videos.

To insert a video, you will find the the Video object in the Too/box under Slideshow objects.
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Image effects | Text effects | Movement paths
Slideshow objects ' Fade-ins | Fade-outs
B Default —————————— =
L s
P ]
H B
[y |
Image Text Video Sound Chapter

Flexi-Collage Partide  Placeholder

You can insert it with a double-click or drag the Video object with the mouse out of the Too/box

onto the Timeline or Storyboard or into the Image list.

Inthe Object settings of the video you now have various setting options. Should the Object
settings not be shown in the view available to you, you can retrieve them by right-clicking the video

onthe Timeline orin the Image list.
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|Dbject settings

V| Show object

Duration: ;:15_{_31 sec 1

[¥] Use default duration {Setkings)
|#]| Leave in place after replay

_.r Tramsparency

o

I= File name
"0 \Medial videolvid_3392284Big Web wrnw" @
Duration: 00:00:14.71

Start kime: D,DD SeC

[#Play complete video

=l Transition
Eﬁanciuljrﬁ'i:ran:;i't'inn '-f |—_
= ackground —
Fill: ;:ﬁ.utomatic {on; '_._ v
Fill calor: [i]
I=I Position
Aspect rakio: ,Keep "_I
Alignment: ' Center il

["|Rotate in direction of movement

Should the full length of the video not be played back, remove the check mark beside Play back the
full length of the video. You can then determine the playback duration individually.

You can crop the video at the beginning using Start time. If you don't want to play the video from
the very beginning enter the point of time where you want the video to start. Under Duration specify
its playing time. This way you select the part of the video to be played.

Should the video not be intended to be played back full screen size, it can be freely positioned in
the Layout Designer. You can also assign a cross fading effect to the video.

The Fill background function enables you to see the previous image during playback of the video
or cover it up with a colored background.

Under Sound you can determine whether the background music is supposed to be faded out during
the course of the video being played. Should you have your own audio or spoken commentaries in the
video, you should use this function.

Further Object settings of the video are explained here.

The video can also be animated with a movement path. How that functions exactly you can find out
here.

Technical information:

Prerequisite for playing videos is a suitable DirectShow filter. In many cases it already exists on
current Windows systems.

SlideShow 8 comes with its own DirectShow filters for a variety of video formats (AC3, H.264, MKV,
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MOV, MPEG1, MPEG2, MP4, MTS, M2TS, Qt, TS, WebM).

If your video can not be played in SlideShow, it could be due to a lack of DirectShow filters for the
video format. Partly they can be installed later. There are different codec and filter packs available for
download. Please refer to the notes to the codec package and also visit the website of the provider of
this package. The installation of codecs can also affect other programs.

Please visit our FAQ (http://fag.aquasoft.de/index.php?action=artikel&cat=15&id=22&artlang=de)
for detailed information.

2.8 Co
e 7ol

In only a few steps, you can create beautiful collages.

Double-click the Collage object from the Toolbox.

llage

F

Image effects | Text effects Movement paths
Slideshow objects Fade-ins Fade-outs
. = Default ——
L et
o~ I:II:I
4 O
QI
Image Text Video Sound Chapter
r=l}.
L
@ r p
L=l “*

Flexi-Collage
= &

Partide  Placeholder

»

In this way a Collage is inserted into your slideshow. Click this Collage in the Image list or on
the Timeline and you will see inthe Layout Designerthat the Collage is empty at the moment. In
order to fill it in, just double-click the Image object from the Toolbox.

Image

In the dialog which now appears, simply select all images to be used for your Collage.

These are inserted into the Collage, since they were selected in the Image list and on the
Timeline. If you click ® next to the Collage, you can view all images in the Collage.
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B v & 1, Collage

e 1 img_ 216,
W & 2. img 278,
LV & 3 img_3...
Lo e 4 img_193...

Starttime  Duration |

0,0s 50s
0,0s 50s
0,0s 50s
0,0s 50s
0,0s 5,0s

1

Omin 0005 min
L 4

2 3
|

g Click here toadd
Mote: the musictrack remains emptyasion

Now simply click on the individual images and drag/maximize/minimize them as you please, until
you are happy with the result. You can reduce the images using the positioning framework in the

Layout Designer.

Layout Designer

Tl

@ O Do T [ e | B 05 [ P | Time marke [0 e 2 || B

=

Now insert a Text from the Tool/box and position it as you please.

Copyright © AquaSoft GmbH 1999-2015



70 AquaSoft SlideShow - Help

If the Text is not inserted into the Collage now, the Collage was probably not
selected when you inserted the Text. Click and simply drag the Text onto the Collage
and release the mouse button. This works in the Image list, on the Timeline and on

the Storyboard.

T S R I

Now you have a finished Collage, consisting of your images and a text. The images can also overlap.
Likewise you can create an image within image effect by not reducing the size of the first image.

If you select the Collage object, you can change Object settings of the collage. You can
determine a transition and change the exposure time.
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Object Settings
|Dbject settings

| [@]Show obiect
Duration: EDD sec :_—l

[¥] se default duration {Settings’
[#] Leave in place after replay

|Image] & Transparency

DG rale B =

= Title

= |

[=| Transition

Random transition - | | Adjust .|
=l Background

m

Fill |Automatic (on; - | &

Fill color: E

[=I Position

Aspect ratio: |Keep g |

Alignment: | ‘' Center - |

"I Rotate in direction of movement

Images and texts within a Collage are not independently animated. To achieve this you need the
Chapter object.
As you can see, putting together a pretty Collage is achieved quickly and easily.

As inan image,ina Collage you can zoom and furnish this with a camera pan. Simply
try it out.
You will find more about movement path in the chapters Movements and Zoom.

2.9 Movement paths

You already learned about movement paths in chapter Text animations.

You can apply movement paths to the following Slideshow objects:

Il‘ I - - |
¥ L
Image Text Particle Flexi-Collage Video

Insert an image which you would like to animate with a movement path.
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Then click on the image in the Image list oron the Timeline. Inthe Layout Designer the tools
for the movement path are now activated.

Layout designer on x

[$168 @O O H- B W% E - Timemak [0005ec 2
(e ’ "\....

[> b [l I # i | 0000000

This is the icon for switching into the mode for movement paths in
Layout Designer.

Using this icon, switch into the mode for camera pans and zoom.

Use this button to insert new movement marks. The course of the
movement is established on the basis of these points.

1 (& (¢

To remove movement marks that have been set, the latter must be
selected in the Layout Designer and can then be removed with this
button.

tx

You can use this to open a further menu for the movement marks.

lﬂ

The chronological course of a path is established with timestamps. You can

Tirne rnark: I thereby determine how quickly the sequence should occur. That is clarified

in an example below.

=] You custom movement paths can be saved and reused. This function is
_I only available in SlideShow Ultimate.

29.1 Simple movement shots
=
@ =

Your images learn to walk. With a few clicks your images wander over the screen. Simply follow these
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instructions and you will be quickly and comfortably introduced to the colorful, moving world of

AquaSoft ® SlideShow.

J
Create a new slideshow and insert an image.

Image

Click on the image in the Image list or on the Timeline, so that the image is displayed in the Layout
Designer.

Layout designer o QL x

In this example we would like to explain how you can arrange for an image to fly onto the screen

from outside. For that purpose, we have to enlarge the invisible area with J .
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——
| @GP T B | 95 9 R T ke [0 -l
! {\ ﬁ Q, El l?_ﬂ:::g. Ean % 1me rrarl seC - E

@]

[F= e T

Now move the image into the invisible area.

e ——————
!'f;‘{\':;‘{\ 'E_%.@-l%;#'%%--Timemark:.ﬂsec s WE

!J_____'I-l _____ (=)

[F = P —

%)
Now insert a new movement mark with
visible area.

. Then move the newly inserted movement mark into the
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lyoutoesigrer  ______=&x]
& 20 0 | Rl [ | B | Timemania 721 |

1 e ) M e s (=)

T R R R

Play back the show. You will see that the image now "flies onto" the screen from the top left-hand
corner. Increase the timestamp at the 2nd movement mark and movement becomes slower.

In order to be sure that the image arrives in the center of the screen and also the size of the image is

i)

not changed, retrieve the Custom entry once via

Layout Designer - Custom entry

IMarkZ -4.00 secl

Cenker:

% so0 [Bg) | widkh: [tnon

s soo (B | Height: loo0.

Time: 4,00 sec Size of previous ikem
Raotation:

Angle: 0.o0° E]

Left: 0 [ Right: oo [
Topi |0 #  pottom: [0 [
Curye bype: |5mooth CLPvE ] |
[~] Relative input [~ | High accuracy

Select Mark 2 and enter 500/500 in the center Also set the Size of previous item. so that the size
of the image is not accidentally altered during the path.

The Custom entry assumes a system of co-ordinates in which the Layout Designeris 1000x1000
units wide. Therefore, in order to center our image, enter 500 at X (the horizontal position of the
midpoint) and at Y (the vertical position of the midpoint), i.e. half of the respective total extent. You
can also use negative numbers. These then refer to the invisible area.
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2.9.2 Movements with alterations in size

In the previous example there was no change in the size of the image along the movement path. Now
we would like to show you how to change the image size in the process. This way images can grow or

shrink.

Images grow

The image with the path set from the previous section also has to be modified slightly.

You should see it like this in the Layout Designer:

]
NIy AT e——— T

e R o e A

| |
Now open Custom entry using the icon.

Select the 2nd mark and change the setting under Size to Freely adjustable.

Layout Designer - Custom entry

IMark2—4.DD secl - |

1 so0 [ width: o [fy)

¥ so0 [fg)  Height: oo [
Tirne: 4.00 sec

Raotation:

angle: 0.0e @

Left: 0 Fd  Rioht: oo [T
Tap: 0 Binttom: oo [ty
Curye bype: |5mooth CLPvE ] |
|| Relative input [~ High accuracy
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Then close Custom entry. It is possible to also carry out the next step from this menu, however we
are choosing the Layout Designer directly.

Using the positioning framework, reduce the image at the first mark, i.e. the mark which is
outside the visible area. Then move the mark closer to the visible area.

owsvesger o0& x|
@ O Do | [t | B B [ | Time marke[05ec 2 |

o
- - -
o Qoo
o--a--%_
\'\._\

TR R

Now play back the show and you will see that the image is larger when it is in motion.
You can selecta Transition, oralso None, inthe Object settings of the image.

First of all, position the first mark in the visible area. Then restore the Layout Designerto Normal

Then access Custom entry.

view using

Layout Designer o B I

wiidth:

Height:

|Free|y adjustable

Right: 25 [ty
Top: 45— Bottam: 255 _—

Curve bype: |Sm00th Curve - |

[ | Relative input High accuracy
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First of all set the values shown in the image. In the Object settings of the image select a

Transition. Afterwards play back the effect.

Now the image should fly back to its original position. For this, two additional movement marks
are required. Click the 2nd mark in the Layout Designer and then insert an additional movement

%)

mark with

Layout Designer (o B I

@ B O [ | s e | B 05| B | Time ke 9 5ec |

T S T

This mark is required to allow the image to stand still. The image should not become smaller again
immediately. In this case a movement mark can be directly laid over a previous mark. To do that, you

only have to drag Mark 3 over the top of Mark 2 now.

Layout Designer = i I

GRS @Qi@ il%ﬁ?i% %i i Timemark-:|
()]
| ]

TR R

Then increase the time at the 3rd mark, as given in the image above. Then insert a 4th mark with
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w
J . You will not recognize this immediately, since it is inserted exactly over the top of the 2nd

|

and 3rd marks.

Retrieve Custom entry using

Layout Designer - Custom entry

IMark 4- 13,00 secl hd | :

¥ 70 [ | Height: 250

170 wiidkh: 0[5
&

Tirne: 13.00 sec@ |Freely adjustable L |

E-j-;&s:

Left: 45 [T 205
Trp: 45 [y  Bottom: 295 [fg)
Curve type: |Smooth curve - |
[7| Relative input [~ High accuracy

Now, under Center and Size set the values which have already been used at the first mark.

If you now play back the show, you will see that the image is enlarged and then reverts to its original
place.

Now insert a new image into the show. Click on our image above once more and access the context
menu using . There select Copy path. Now mark the newly inserted image and access the

Inthe Object settings of the 2nd image you have to disable the Fill background function.

context menu again using and this time select Insert path.
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1 Sound | “ir Tramsparency

D0 | at Bo >

[= File name

O\MedialImagesiimg_1930704.jpg =

[= Transition

|Randnm transition - | |. Adjust 1|
= Background

[F o e
Fill color: E

m

= Position
Aspect ratio: |Keep - |
Alignment: |' Center - |

[T 1 Rotate in direction of movement

Now we will for once change the positions of the first and last marks. To do that, access the context

menu using

Mark 1:

Layout Designer - Custom entry

IMark 1-3.00 secl

: | so0 [B] widkh: 50

i 170 [*d || Height: 250 A
IIime: 3.00 sec I |F|'r:c—|y adjustable i |

angle: n.o-

Left: 75 Right: €25
Tap: 45 Binttom: 295 [Bg)

Curyve bvpe: |Smooth Curve i |

| Relative inpu [F| High accuracy
| Relative input High

and accept the settings below once.
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Mark 4:

Layout Designer - Custom entry

[Mark 4 - 13,00 sef

o
= 4

170 [*d | | Height: 250 A

Tirne: 13.00 sec |F|'E|_=Iy adjustahle = |

Left: 375 Right: g5
Tap: 45 Binttom: 25 [

Curye bype: |5mooth CLPvE ] |

Relative input [~ | High accuracy

Then play back the show once in its entirety. And how do you like the effect?

In SlideShow Ultimate you can use Rotations. This is easy to accomplish via Custom entry, too.

Open the context menu for an image via —I and select the 2nd movement mark. Under Rotation
set the angle to 360 degrees. Do the same with the 3rd movement mark.

Layout Designer - Custom entry

Layout Designer - Custom entry

IMarkZ-?.DD secl - |

{mark 3 - 11,00 sec|

% so0 (B | width: oo [y

Width: wan [
¥ so0 [fg)  Height: won (B Height: won (B
Tirme: 7.00 sec |Freely adjustable - | Time: 11.00 sec |Freely adjustable - |

Angle: 360.0° [E 1.0 Turns right Angle: 360.0° [E 1.0 Turns right

Edges:

Left: 0 Right: o %)
Tap: 0 Binttom: won B

Curye bype: |5mooth CLPvE ] |

Edges:

Left: 0 Right: o %)
Tap: 0 Binttom: won B

Curye bype: |5mooth CLPvE ] |

| Relative inpu [F| High accuracy | Relative inpu [F| High accuracy
| Relative input High | Relative input High

Play back the show.

These movement paths can be used on the following Slideshow objects:
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i T & B

Image

293

Text Flexi-Collage

Video

Movement paths with rotations

Movement paths with automatic rotations can be applied to the following Slideshow objects:

|I —q "5 m
| W |
Image Flexi-Collage Video

Images, Collages and Videos can now be rotated automatically directly at the movement path. This
way it is possible to correctly rotate cars or planes according to the direction of their path.

@

You can activate this option in the Object settings.

Layout Designer

This feature is only available in AquaSoft ® SlideShow Ultimate.

Object settings
[#] Showe ohject

T
Durakion: EZD 00 sec

~ | Distance: 0.00 sec :_I

[7 Use default duration {Settings)
[¥] Leave in place after replay

I Image ] ' 1 Sound

"= Transparency

-2 ,5%4? —

D File name

Data'l,AutoDrauFﬂchtGelb.png ;3

| [zl Transition

GG @Qi@ii%iﬁ'i‘ﬂ;%iiﬂmemark: Msec 2| EH
9] &}
Q--0-- o--0- "-—rl
| s VA
- - - - - - - <¢eud
G G o
o--0-0 O--0-0 I:P~ -5
D ftptﬂ.[ﬁec
o of B
o--0-- D__u_n{:',-n--n
"J-_ 3 I~=.-=_- —————— -£3 {}}*‘f" .lﬁ:-r_
0 ,’Im_ ] l-*_ d}|
at o--%-0 Oo---0
G--0--0
E|l -”Emuﬁ___‘r,
Ky . @ o
o-8-0
g--o-0 p--0--0
ST — — — — — - 5 E0sp. O
O--o-0 o--o- H“‘-Ug =
T |
O O ? ?. .U?:':
O--0--4 o--o-874-0
- - - - g oG-
D--n - et
e

|N0ne v| [ adjust .| =
| =l Background

Fil: on. | B

Fill colar:

|=| Position |4
|

Aspect ratio: |Keep T |

Alignment: |' Center ™ |

|iE Riokate in direction of movement

Click the —I

rotated along the path.

icon and then Select all marks. You can see that the the car gets automatically

Copyright © AquaSoft GmbH 1999-2015



Design options in AquaSoft ® SlideShow 83

2.9.4 Text with movement paths

Just like images, you can also let text move along movement paths. Please read the chapter Simple
movement shots first to get to know how to set movement marks.

Create a new slideshow and insert a object.

G G R R S T RS Timemark: (0sec 2|

Now use to add several new movement marks. Position them in
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In the for

i
gd
W

If you replay this small example you will see that the text moves along the path.

[#] arial  abcoErchi w36~ (-

= Style Alignment
A E =
= Text

Texk with movement path

= _E_ffll:lct

1\ @?D E Border colar: |- '|

Animation: o

Delets text effect -| | T Edit

Rotation around bext
center

Behavior along a movement Path:

-

|Text block

exists an option to specify the behavior of the text along the path

during replay.
This feature is only available in AquaSoft ® SlideShow Ultimate.

The text remains horizontally and moves along the path.
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The characters are separately animated and snuggle up to the path.
The whole text gets rotated along the path.

The characters move separately along the path and snuggle up to it.

Example: Rotate characters

HH E Current time: 00:11.208

29,5 Camerapans

Create a new slideshow and insert an
]
A
Image
Click on it in the or on the , so that the image is shown in the

and the corresponding tools are enabled.
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Layout designer

b
..

_AUGHING W

' o

v

-

3

With camera pans the images must be enlarged beyond the visible area. For that purpose, reduce the

display of the visible area with the —l icon.

Layout Designer

afa]e

ez ||lﬂ'j‘€? | R | |-fl'jmem_a_|=k-: |

O

Now enlarge the image using the positioning frame until it looks similar to the image below.
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]
@ O Do | [t | B B [ | Time marke[05ec 2 |
L]

TR R

1
Then, with the —, , insert a new movement mark and position it to the left of the first movement
mark.

]
@ G B | [T ol | B %6 | | Timemarka [25ec ||
(e

L= = = = = = = = = [ | = = = = = = = = =] |

e s b o e

Increase the time at the second movement marker, so that the movement is carried out more slowly.
Should you not wish to have any Transition at the beginning of the movement path, you can set
Noneinthe Object settings of the image.

Then, with the right mouse button, retrieve the context menu at the 2nd movement mark marked.
Now, in the latter, select Position frame/Use size of previous item. As a result, the size of the
second movement mark is automatically adapted to the size of the previous one and can no longer be
changed accidentally.
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-1

R
%

B

Eﬁ:

Add movement mark Ins
Delete moverment mark(s) Drel
Copy path

Smooth curve

Hard curve

Position frame

Equalize path

Invert path

Edit path

Manual input Ctrl+M

Select all marks Ctrl+ A

ME &

il e

Now simply click

2.10

ep &

Designerwith a ....!J .

Zoom

Size of predecessor
Custom size

Scale to full screen

and enjoy the effect.

Every image with the setting Use size of previous item is marked in the Layout

Wwith AquaSoft ® SlideShow you can also zoom into your images. If you want to show a particular
section of an image enlarged, you can generate this using the corresponding tools in the Layout
Designer. In that respect, you can freely choose the area which you would like to zoom in on.

You can apply Zoom and Camera pans to the Slideshow objects below:

] & Bl

Image Flexi-Collage Video

Copyright © AquaSoft GmbH 1999-2015



Design options in AquaSoft ® SlideShow 89

You might find it useful to skim through the movements tutorial first since the zoom function is
based on the movement path system.

Zooming into an image easily

0|

Create a new slideshow

w

Image

and insert an image.

Click on the image in the Image list or on the Timeline, so that the image is shown in the Layout
Designer and the corresponding tools are enabled.

&
Select the —I

icon from the upper edge of the Layout Designerto enter the Camera pan mode.

Layout Designer = i I

'?{\':;‘{\"ﬁﬁi@;% I.%%i;Timemark:ﬂsec s E

e R

i
Now click the J icon. This inserts a movement mark. A position frame is now drawn around
this additional mark. Reduce the size of this mark by means of the position frame and drag the
section to the place which is supposed to be enlarged.
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Layout Designer

(I 19 .

T S R TR

So that the Transition does not have a disturbing effect on the Zoom, you can set the Transition
inthe Object settings of the image to None orincrease the Timestamps.

The 2nd mark is still marked (orange). First of all set the time there at 4 seconds. Then click the first
mark in the Layout Designer and set the value to 3 seconds or more.

Layout Designer =R I

'?Q'?%'?ﬁi@;%iﬁiéﬁﬁi;Timemark: isec I (HE

You can see that, by changing the time of the first mark, the subsequent marks also change
automatically. In this way the movement set remains unchanged within the path.

The exposure time of an image is increased automatically if the time of the movement
1 path becomes greater than the Duration set in the Image Object settings.
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id

Motion in the image

If you would like to zoom in on several sections of an image, you can now use a movement path in
the image. Imagine you have a group photo and now wish to zoom in on the individual persons.
However, you do not wish to constantly zoom in and out, but go over the faces in the image.

=]

After clicking you can play back the zoom effect.

For that purpose, you can now insert an additional movement mark with the icon. Position the

mark at the desired final point.

Layout Designer =RV 4

G N T B R SR e ol Time mark: |9 sec * B

] - r

If you now play back the effect, you will now see that a camera pan is possible within the image.
Using the time of the last movement mark you can control the speed. If you increase the time, the
shot becomes slower.

Zooming out

You can have the image cross faded while you are zoomed in on the section, or first revert back to
the overall image size.

In order to revert back to the full size, insert a new movement mark. Please ensure that the last
movement mark is selected.
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Layout Designer

g0z

The easiest thing to do is now to use the Custom entry. Retrieve this with a right mouse-click

button or by using the = icon.

Layout Designer - Custom entry

{mark 4 - 11,00 sec|

500 [ || width: 1000
i 500 [*d || Height: 1000

Time: 11.00 sec

|Freely adjustable

i |

Lefts

Top:

0
0

Right:

Bottom:

1000

1000

Curve bype:

|Sm00th curve

= |

Relative input

High accuracy

At Mark 4 set 500/500 as the Center and 1000/1000 under Size . As a result, the image at Mark 4
is displayed in its entirety, again.
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Layout Designer = l

!'?{\ EX '.'!_‘\Q.-El-c%ﬁ:{zl'ca;%--ﬂmemark: sec 2 (WE

[F= e T

>|

If you would like to leave the image at the end exposed a bit longer, increase the
Exposure time of the image from the Object settings. After the end of the movement
path, the image then continues to remain on the screen.

Now simply click and enjoy the effect.

When aligning the movement marks, it may occur to you that they snap magnetically to
other movement marks and to horizontal and vertical lines of other movement marks. You
can prevent them snapping this way by holding down the Ctrl-key on the keyboard when
moving the mark.

Furthermore, the movement marks are also aligned to the grid which can be enabled using

the @l

icon.

As you can see, it is very easy to zoom images. Simply insert movement marks and position them as
desired - and already motions enters your image.

The movement path can be changed using the Curve type. Select Select all marks by means of
the —l

In the context menu which now appears, select Curve type -> Hard.

icon and click in the Layout Designer with the right mouse button.
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°

Add movement mark Ins

e 2 (M

Delete movement mark(s) Drel

Copy path

Smooth curve

+ ™

Hard curve

Position frame [
Equalize path
Invert path

Edit path k

non
-

Manual input Ctrl+M

Select all marks Ctrl+ &

You will now see the change in the form of the movement mark. This is now square, in order to
represent the chosen Curve type.

After clicking —I you can see the change in the zoom. The pan in the curves is now Hard and is
no longer carried out soft.

2.11 Rotations
e Ol

Just camera pans are not enough for you? You want more zest in your slideshow? Add freely
definable rotations to your images.

This feature is only available in AquaSoft ® SlideShow Ultimate.
'ii
L

The following objects can be rotated:

T - [@jm

Image Text Particle Flexi-Collage Video
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It doesn't hurt to read the tutorial Movements first because the rotations are combined with
movement paths. The chapters Rotating text and Letting texts fly give more information about

rotating text.

Create a new slideshow

w

Image

and add an image.

2]

Select the image in Image list or Timeline to display itin Layout Designer. The use the
button in Layout Designer to zoom out a little.

Layout Designer =1 I

5'3_’\{\ NG SR %z{#’%% Tirme mark: |0 sec :-E

I T [ Py 1
- I,IJ_\/' | g ¥y ey

Now you can use the green handle to rotate the image. Click it, hold the mouse button down and
define the rotation angle. Use the Position frame around the image to decrease its size.

Copyright © AquaSoft GmbH 1999-2015



96 AquaSoft SlideShow - Help

Layout Designer = '

G S G S W R %#’ = Time mark: [0 sec : =]

| |
| g | e by ey

The black area in Layout Designeris the visible area. Images need to be positioned in

purposes like e.g. images or texts that "fly" in from the outside.

li this area if you want them to be displayed. You need the outside area for special
L

To manually specify the rotation angle click on the image in Layout Designer and select Custom

entry.

Layout Designer - Custom entry x

¥ 70 [
Time: 0.00 sec

angle: 2507 0.1 Turns right

Left: 250 Right: 750
Top: 97 Bottom; 444 i
Curve bype: iSmooth Curve - |
[7] Relative input [~ High accuracy

Now enter the Angle under Rotation.

Beautify your Collages by rotating the images in the Collage. Texts can be rotated this way, as well.

Of course this is not all you can accomplish with the rotation functionality. Would you like to trace
your travel route with a car on a map? Then you can learn how to combine movement marks with

rotations.
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|

In our example we let the car follow a road. First we add the image of the road using the
button. Instead you can add your image of the map.

Imagelist B 0 X | Layout Designer | Rox

| Object Starttime  Duration ||
- (W ' 1. Strasse.jpg 0.0 sec 2.1 sec

'l T | P T S O e

Now we need the car. Preferably it should be a PNG graphic with alpha channel.

@

Add the car.

Please consult the FAQ about how to create this type of graphic.

|| Object Start time  Diuration
- v . 1. Strasse.jpg 0.0 sec 2.1 sec
v @& 2 AukoDraofsi.. 21sec 290,

4 11 | 3 15 [ F B L S B |
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Decrease the size of the image using the Position frame.

= B X | Layout Desi =R I

iD ject Starttime  Duration | GRS T | £ |I%l‘€;. | Rt | | Time rnark: |

v t 1. Strasse.jpg 0.0 sec 2.1 sec
- v @& 2 pukoDraufsi.. Z1sec  29.0...

I i P

U
Now you can start the tour. Add a movement mark J and rotate the car a little, following the

direction of the road.

Add more movement marks and rotate the car accordingly.

You can adjust the time marks for each movement mark individually. Click on a mark, it will then be
highlighted. Change the time mark in the menu bar above the image.

O B O | | Bef | B | B | Timemara[155ec S| H |

|

Now replay your show via
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Eventually the complete movement path should look similar to the following graphic.

_ T —
| Object Start time  Duration I '?Q f% '5'_7'(\ | @ !I%“{? | Rt | i Tire mark: |0 sec - i

| v .— 1. Strasse.jpg 0.0 sec 2.1 sec
- v @& 2 pukoDraufsi.. Z1sec  29.0...

] 11 PLJ*IEMWW b el

The rotation angle can be larger than 360 degrees. This way you can simulate effects

ld like the skidding of a car out of a curve.
L

2.12 Image effects

Wwith AquaSoft ® SlideShow you can now also apply image effects to your images and in this way
present your images even more impressively.

In the Toolbox you will find the Image effects.

| Slideshow objects I Fade-ins | Fade-outs

! Image effects | Text effects | Movement paths

Standard
Frames
Masks
[# Caolors
Retro
Custom image effects

Filter x =) ———

The Image effects are subdivided into various categories. With the plus icon you can open up the
individual categories.
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Image effects

! Carmman

CEEEE

Delete all  Cutinto pieces Glow (Black)  Glow (Blue)  Glow (Red)
image effects

B B B B B

Glow wvhite) Glove (vellow)

Mlirroring Fin {top) Polaroid

Image effects can be applied to an image very easily. Insert a few images into an empty slideshow.

In order to now being able to apply the Image effects to these images, simply drag the desired
effect out of the Too/box to the image in the Timeline.

Image effects

e

Delete all  sHE@EGNEE Glow (Black)  Glow (Blue)  Glow (Red)
image effects

= B

Glow (White} Glow (Yellow)  Mirroring Fin (top) Palaraid

zwyith multiple £

Mote: the musictrack remain

You will see the change in the Layout Designer. The effect becomes properly visible when playing
back.

If you would like to assign an Image effect to several or all images select these images.
All images = Ctrl + A
Certain images = Ctrl + right click on the image

Select the Image effect with the left mouse key, then click right and select Apply. The Image
effect will be assigned to all selected images.
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4| Image effects

Apply

Delete all  SHEEE . . Glow (Red)
image effects Increase ican size

Decrease ican size

h L Tahs left h

Glow (White)  Glow (¥ Ol 16 cnon Polaroid
Tahs right
Tabs at the bottom
[ 7 ] [] L 1L (¥] 15 14
0215 min

Y, Cli
Mote: the musictrack remain

If you want to remove an Image effect again, in the category Com mon you will find the Delete all
image effects object in the Image effects.

Delete all  §Cut into pieces Glow (Black)  Glow (Blue)  Glow (Red)
image effects

e B B B B

Glow Owhite) Glow (vellow’  Mirroring Fin {top) Polaroid

Simply drag the latter from the Toolbox onto the image on the Timeline in the case of which you
wish to remove an effect set.

In AquaSoft ® SlideShow Ultimate you can create and edit such effects yourself. A special Effect
editoris available there. It is explained in chapter Image editing.

2.13 Animated transparency

In AquaSoft ® SlideShow a transparency behaviour can be assigned to some Slideshow objects.
This creates impressive effects. For instance, it is possible to let an image or text slowly appear from
a black background and later disappear in it.

In this way images and texts can also appear semi-transparent on a previous image.
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You can apply the animated transparency to the Slideshow objects below:

i T & B

Image Text Flexi-Collage Video

You will find the corresponding possibility for setting them in the Object settings of the
respective Slideshow objects.

Object Settings
|Dbject settings

W] Show object

Y

Duration: [2,00 sec 3 |

[7] Use default duration {Settings)
|¥| Leave in place after replay

& Click on the graph to add tAnsparency points.

ool o025 05 075 100 125 150 175 20
Duration (in seconds)

Now with the left mouse button set markers in this system, which then form a transparency curve.
On the left-hand side you will find the value of the transparency (in %); at 100% transparency the
image is completely transparent (i.e. no longer recognizable), at 0% it can be seen completely. Above
the curve you will find icons, the meaning of which is:

'F;I Points are round, the course of the transparency animation is soft.
U Points are square, the course of the transparency animation is hard.

nll If you have clicked a transparency marker (appears orange), you can delete the marker by
clicking the icon.

If you have changed the exposure time of the image or text, you can, by clicking this button,
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have the transparency set adjusted to the exposure time.

Move the markers by clicking an existing marker and keeping the mouse button pressed down. Now
simply move the marker to the desired spot and release the button again. In order to delete the
animated transparency entirely, you will have to remove all transparency markers.

Image

2.14 Background music

A perfect slideshow not only includes impressive effects, but also background music. The Timeline
provides its own sound track for Background music.

Click this sound track and the Background music menu is opened.

By means of the plus icon you can insert music onto that menu.

If you click the song, you can make further adjustments.
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Slideshow settings 3]
[ Slidesh B
s Background music
hain settings
5I|des.h0w flows Backg i
Transitions B &
Hiisic selings . i M 12 | ®) | £¥ | £ - | pownload GEMAfree music
Backgiound music
Diescription 1 J C:AJ sershPublichMusichSample Musichkaimba mp3 548
Loga f s
= SlideS how-Player i
Standard Player [Directx)
00zec =
2006 sec =
10z =
i00sec 3
10z 2
! oK LCancel Help

You can insert one or also multiple tracks. These are then listed below one another in the
CE list. You can change the sequence by clicking the track and moving it in the list with the
mouse button pressed down.

Removes a selected track from the list

=

Plays back a selected song

Opens the music settings

ks

Fade-in zong D0sec = | A track can be gently faded in. In this case state how many
: second the fading in should last until the full volume
should be achieved.
Fade-out song D0sec = | Songs can also be gently faded out. In other words, they are
: getting more and more quiet prior to the end. Here set the
time, how long prior to the end the fading out should start.
Yalume ooz :l Specify here at what volume the track should be played
: = back.
Start sang after 0.0 sec :l You can delay the start of a track. Specify here the length of
: = the delay.
Start mest song after M.0sec = | If you do not want the following track to begin immediately,
' specify here the length of the break between songs.
Start position (0.0 zec ';'=| It is also possible to only play a section of a track. Here you

determine from what point in the song playing should start.
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For example, 20 secs —-> The song begins at the 20th
second. The first 20 seconds of the song are not played.

0 -> From the beginning.
End position 00sec 2| Here you can determine when the song should end. In that
" (0 = until EnEi'] respect, the timestamp in the song is to be selected again.
If you want to end the song after 2 minutes, enter 120 secs
here.

Example: Starting and final positions

You wish to only play T minute of the song. However, the part of the song which you would like to
play back begins at the 45th second.

Starting position = 45 secs

Final position = 105 secs

You will see the music in its own track in the Timeline. The sound wave display will have alternating
colors to make it easier to see when a title starts and ends.

The volume of the background music can be set individually. In the next chapter you will learn how

this is done.

Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ®

! SlideShow does not support the use of music tracks which have been encrypted by
- DRM or similar procedures.
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2.15 Custom volume settings

For each title, no matter if it's Background music ora Sound object, you can separately adjust the
volume. This happens in the Timeline.

0012 min

To get the line, click the wave form of the title. Each click creates a mark that can be moved to adjust
the volume. A right-click on such a mark will delete it. The line will be removed when the last mark
was deleted.

Background music will be automatically faded-out when a Sound object starts. You
l don't need to do this manually. You can configure the fade-out volume and duration in

the music settings.

2.16 Sound objects

If you have undertaken the desired adjustments with an object/image, you can drag it out of the
Image list or Timeline to the Toolbox. A window then opens for saving the template. Enter a name
there.

Image effects | Text effects | Movement paths |
Slideshow objects ' Fade-ins | Fade-outs |
B Default ———————— =
0 Y e Emal -
A ]
lllllllllll Eﬁ
Image Text Chapter
e
~ W
@ . 7
L
Flexi-Collage Partide  Placeholder -
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Afterwards you will find the template in the Toolbox under Slideshow objects -> Custom

objects. Click the object and then select the images. These are then inserted with the desired
template.

The Sound-objectis usually used if a sound will only be played over the length of a certain number

of images. This is accomplished by using a Chapter. You can find an example in chapter Multiple
tracks.

Here you can find a chapter about Sound-properties.

SlideShow does not support the use of music tracks which have been encrypted by

Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ®
ld W
- DRM or similar procedures.
imilar p u

2.17 Saving own templates

After you got a bit familiar with AquaSoft ® SlideShow there is a multitude of options for own objects waiting
for you. The goal is to reuse nicely designed compositions and thus saving of time. The principal is simple. You
know the different kinds of objects by now. Together with your comments and settings whole slideshows or
parts of them came into existence. Some parts are usable only for the slideshow they belong to, in others

there are elements that are commonly usable or at least a few times. If you created such elements you can
easily save them as new objects.

If you have applied the desired adjustments to an object/image, you can drag it out of the Image
listor Timeline to the Toolbox. A window then opens for saving the template. Enter a name there.

Create/Edit template ==

Mame:; Image - adjusted

Title: Image, adjusted
Author:

Description: Image with font Verdana in size 36

Activate all objects whose file names should be adjusted when using the template.

Object
~[¥] @3 1. shutterstock_43289754.ipa

Cancel

Afterwards you will find the template in the Toolbox under Slideshow objects -> Custom

objects. Click the object and then select the images. These are then inserted with the desired
template.
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i@ File browser

Image effects Text effects Movement paths

Slideshow objects Fade-ins Fade-outs

= Controlling -

>

[=] Custom objects

Saving own text effects

Ula

This feature is only available in AquaSoft ® SlideShow Ultimate.

[

If you made changes to a text effect and would like to save them, just click on the “icon.
R Toc sfec B
Text whirl be

Fade in | Fade out
Zoom b
Duration: 5,00 sec % -
Characters simultaneously: 43 e
Font width: s 100%
Font height: s 100%
Number of rotations: 0 .

i gy

Center of rotation:

Random order

| Movement

/| Consider letter position

Start position:

Fixed path:

- Modulation

Character center

+ Activate alphablending

Rotate in movement direction

Fixed path -

4k 4r

Loop -

Cancel

A dialog opens that lets you save the template.
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 Teteffect save

You can save the Text effect for your own use or export it

Enter the name for the Text effect here,

Mame: iText whirl

After the Text effect was saved it will be added as a Custom text effect to the Toolbox and can
now be applied to other text/images.

Toolbox

Slideshow objects | Fade-ins | Fade-outs

| Image effects | Text effects | Movement paths

Zoom in (bottom left) Zoom in (bottom right) Zoom toward edges

E Custom text effects

Text whirl

e x| e -

Saving own movement paths

'«

Movement paths can be saved, as well. Click on the

This feature is only available in AquaSoft ® SlideShow Ultimate.

a

iconin Layout Designer.
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A dialog opens that lets you save the template.

Save Movement path x

You can save the Movement path For your awn use or
export it For distribution,

Enter the name for the Movement path here,

Marne: fSize cHange

[ Save o Export | | Cancel

Peek.in {twice,
rotated)
= Custom movement paths ae——

m

After the Movement path was saved it will be added as a Custom movement path to the
Toolbox and can now be applied to other images.
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2.18 Using the SlideShow-Master

®

The SlideShow-Master contains a series of slideshow templates which make it easy for you to
create a slideshow.

At lightning speed you can select images and music to create an attractive slideshow in connection
with a style.

Under File -> New -> Use SlideShow-Master you can access the SlideShow-Master.

2B SlideShow-Master
[ . SlideShow-Master
The Slideshow-Master helps you to create a professional sideshow with just a few
simple dicks.

You dedde about the images and background music for your slideshow. The wizard
creates an astonishing slideshow with one of your selected templates,

After creating the slideshow you can make further adjustments and burn 2 video-
or PC- slideshow.

Click "Next” to continue.

Cancel | Bac | | Mext =

Click Next to begin designing the slideshow.

In the next step please insert images using the Plus icon.

' 2R SlideShow-Master

& M| @ | Timages

shutterstoc...  shutterstoc...  shutterstoc...  shutterstoc...

7

shutterstoc... shutterstoc. ..

Cancel | < Back | | MNext =

Then click Next.

Now insert your desired background music using the Plus icon.
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==
Add background music
& M@ 12 | #) | £ - | Download GEMA-free music
3 "dh C:\Users\PublicMusic\Sample MusiciKalimba.mp3 5:48 |T|
4]

E]Adjjst:ixaﬁoﬂcf&vesﬁded’:owm&sedxaﬁmnfhebadqmﬂdmsic

< Back Mext =

Cancel

I adjusted to the duration of the music.

Next click Next.
Now select a style template.

BB SlideShow-Master (==

Select style 'k
| [ Mo description available
116:9

|| Winter 4:3
Mo description available

« [

| PR Clouds 4:3
| ‘four images wander across the sky with fluffy douds.

More templates on the Internet. ..

Start preview

Mext =

< Back

Cancel

With the Start preview button you can inspect the style template.

If you don't want to adjust the duration of the slideshow to that of the background
music uncheck this option. With this option enabled the duration of the images will be

With some templates you can enter a film title and further personal details. For that
purpose, simply click the personalization data directly and enter your desired text.
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’ 2R SlideShow-Master

Auther

Icd

. Strtpreview | preview

Summer vacation 4:3
Mo description available

Steel
Mo description available

[T

More tes on the Internet...

< Back | | Mext = |

Next click Next.

Now you can decide what the next step should be.

’ = SlideShow-Master

mare,

Edit slide show

After creating the slideshow you can continue to adjustit.
Images can receive comments, sounds, animations and much

Burn PC slide show to CD
Creates a data CD that can be played on a PC. You can also use
this method to archive your slideshow for later changes.

Burn video to Blu-ray, DVD or (S)VCD

Burn the slideshow to a video-CD, -DVD or Bluray disc to play it
on your DVD/Blu-ray player. You will then not need a PC to view
the siideshow.

< Back | |

Edit slideshow:

PC DiaShow auf CD
brennen:

Video auf VCD, SVCD oder
DVD brennen:

Opens the style template with the images in AquaSoft ®
SlideShow for editing. It is now possible to make individual
adjustments.

This option opens the CD Wizard and you can record the show on a
CD or prepare it for passing on. The CD recorded can then be
reproduced on a PC (not on a DVD player).

This option opens the Video Wizard. With this the slideshow is
recorded on a video CD or DVD. First the show must be converted
into a video.
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3 Properties of slideshow objects

As you hawe already learnt in the previous sections, there are so-called Object settings for the Slideshow
objects. In these you can configure specific settings for the respective objects.

You will find the Slideshow objects inthe Toolbox.

The Object settings can be shown fixed on the user interface (always embedded) or also only
displayed when required. If you do not show them on the user interface, you can access the Object
settings at any time by right-clicking the relevant object.

The following fundamental properties are available with every object:

[#] Show object | Determines whether the object should be shown when playing back the
slideshow.
Duration: [5,00 sec = | | | Here you can set the exposure time. In other words, how long, for

-}

example, an image, text or video is supposed to be shown. The cross
fading effects take place within this exposure time.

[#] Use default duration (Settings) [ In the Slideshow settings you can set a standard exposure time for
your Slideshow objects. If you change the exposure time there, this
applies to all Slideshow objects in the show in the case of which the
standard exposure time was enabled and to Slideshow objects which
are newly inserted.

[#|Leave in place after replay | Normally an image or text is cross faded by a subsequent image. In
that respect, the image lingers. If it is not desired in the case of a
particular animation, the lingering can also be turned off.

If you deactivated an image of your show (Show object deactivated), it will

! not be displayed anymore in the Timeline. The Timeline displays only
', objects that are supposed to be replayed. If you want to reactivate an image
you can do this in the Image list or in the Storyboard.
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3.1 Image
Inthe Object settings of an Image you can configure the following settings:
Image
Object settings o3 x
Object settings
|| Show object
Duration: |11,00sec 3 | Distance: 0,00sec 3 |
Image lT Text | i]l] Sound | @ Transparency |
DO L B
= File name
Data\Peach.jpg _‘3
Fade in: | Random -
Fade out: Leave in place (do not hide) -
Fill: |on - I
Fill color: . -
Aspect ratio: _-Ke__ep ” |
Alignment: I Center -
| |Rotate in direction of movement

E B @ ®

il

Rotates the image counterclockwise.

Rotates the image clockwise.

Opens the Image editor.

Specifies a movement path.

Specifies a camera pan.

File name Shows the path and file name of your image.

Aspect ratio Images have an aspect ratio which is comprised of the height

and width of the image. If an image differs from the aspect
ratio of the slideshow set, it can be decided here how the
image should be represented.

Copyright
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Keep: The image retains borders when being played back.

Crop: Parts are cropped from the edge of the image until the
image fits into the correct aspect ratio without edges
emerging.

Distort: The image is inserted into the aspect ratio of the
slideshow, whereby a distortion of the image takes place.

Alignment Determines the position of the image on the screen.
Rotate in direction of If you assigned a movement path to an image you can let the
movement image automatically rotate along the path. This function is

only available in AquaSoft ® SlideShow Ultimate.

Fill background On = Background gets a color filling when display size of the
image is reduced.

Off = Background doesn't get a filling and the previous object
"looks through". For images inside collages or Picture-in-
Picture effects it has to be Off.

Automatic = The slideshow sets filling to On automatically for
images /videos/collages in the first track. If you move an
object to the second or a lower track filling will be set to Off.
This way Picture-in-Picture effects can be created quickly.
If you want to the value to remain select it from the drop-
down box.

Transition Here the Transition can be set or also deselected. For that
purpose, in the drop-down list there is None as the first
option. With the Adjust button, the transitions can be
configured. You can also obtain a preview of all transitions
there.
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frial ABCOEfGH] w 26w
eil=

[zl Style Alignment

A =@=_-=

=l Text

= Effect
A | 3D E Border color: | | -
Animatinn: N
Alphablending |
_ Rotation around text  _ Show text with image

~enter

The possible formats are almost always self-explanatory through the icons and you are no doubt
familiar with them already from other text programs.

The Alignment, however, has a minor peculiarity.

[% Positions the text at the lower edge of the screen.
% The text is shown in the center of the screen.

[% Positions the text at the upper edge of the screen.

Places the text freely in order to determine the position in the image
individually.

E;j The text is shown underneath the image. That also applies if the image is shown reduced in
size.

If you don't wish to have separate text animation, activate the option Show text with image.
Should the text be shown animated, you can select various ready-made animations from the list. You
can still adjust the animation using the Edit button. You can also see a preview of the animations
there.

Rotation around text center refers to animations in which the text is rotated. Under Edit you can
also determine a different rotation center.

With Behavior along a movement path you can specify how text gets displayed when it moves along

a movement path. You can choose if the whole text shall move as a block or even as separate
characters along a movement path. In the latter case the characters "snuggle up" to the path.
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Sound
inage | Tect | RIRGRE] - Trence
= Sound
O\ MedialMusicy Artisty01-Titlen 1 .wma >
| & Recard | Curation: 03:19,904 |ﬁ|
= ¥olume
Yolume: 1IZIIZI @ = |

|

[¥] Fade background music (Sektings)

= Replay behavior

Start position; EI;'I,IIIIII s :
(3 Adjust display duration ta sound duration
) Continue sound after end of image

(7) Fade-out sound after end of image

=
1E-0i = ||

Folder icon

Play icon

Record

Volume

Fade background music

Adjust display duration to sound

duration

Continue sound after end of image

Fade-out sound after end of image

Using the yellow folder you can assign
commentaries or pieces of music already included
to an image.

Plays back the music file assigned to.

Opens the Sound Wizard and you can then record
a commentary to go with the image.

Determines the volume of the sound when played
back.

You can determine whether the volume of the
background music should be faded/decreased
when playing back the sound.

Plays back the sound in its entirety and thereby
adapts the exposure time of the image to the
length of the sound.

With this option the image can have a shorter
duration than the sound. The sound then simply
continues to be played on into the next images
until it has come to an end.

Should the exposure time of the image have come
to an end, but the sound be longer, with this option
the sound is faded out at the end of the image.
Under Duration you can set the fading out time.
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Transparency
Animated transparency is described in the design options under Animated transparency.

3.2 Text

Inthe Object settings of a Text object you can configure the following settings:

Object Settings
|Dbject settings

| [¥] Shaw object

D ation: iS,DD s8C :—l

[¥] Use default duration (Settings)
|¥] Leave in place after replay

":'Z._.! Transparency
| = Font 1
Arisl  MRCOEfGH] w 26w
ES_H'IE Alignment —
BA B==|_-=
= Text
Texk
= Effect
A SD € Border calor:
Anirnation;
Delete text effert - | |[ T Edit 1|

__ Rotation around kext
[l center

Eehavior along & movement path:

| Texk block =

The Text Object settings do not differ from the Text Object settings for images. In this case
only the Show text with image option is not available. The Text object is an independent
Slideshow object, nonetheless, it can be faded into images and videos.

If you want your text to be moving along a movement path, please have a look at chapter Text with
movement paths.

Transparency
Animated transparency is described in the design options under Animated transparency.
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3.3 Video

With the Video object you can configure the following settings in the Object settings:

Object Settings m B E

|Dbject settings
[#] Show object
Duration: 5-15,31 sec :.

[¥] Use default duration {Settings)
|#]| Leave in place after replay

M “is Tramsparency

% &
I= File name
" \Medial videovid_33922546ig Wweb, wrm”
Duration: 00:00:14,71
Start kirne: ::D_,DD ser :_!
[ Play complete video
I= Transition
;Bandnm i:E'u:;i-t'inn '_i | Adjust

= Background

Fill: ;.C\utomatic {on; *'_] &

Fill ealar:

= Position
Aspech ratio: EEéep
alignment: | '™ Center

[FIRotate in direckion of movernent

Video

File name

Duration

Start time

Play back video entirely

Aspect ratio

Shows you the path and file name of your video. Using the
yellow folder you can also exchange the video for another
video file.

If you have once changed the playback time of the video, you
can set the correct video length again with a click on the time.

Here you can specify from which position a video is to be
replayed. If you don't want to show the first ten seconds enter
11.

If the option is selected, the full length of the video is played
back. If you deselect the option, you can set the playback
duration individually.

Videos, just like images, have an aspect ratio, which consists
of width and height of the frames. If a video differs from the
aspect ration of the slideshow you can here decide how to
display the video.
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Keep: The video retains borders when being played back.

Crop: Parts are cropped from the edge of the video until the
video fits into the correct aspect ratio without edges emerging.

Distort: The video is inserted into the aspect ratio of the
slideshow, whereby a distortion of the image takes place.

Alignment Determines where the video is supposed to be positioned on
the screen.

Rotate in direction of If you assigned a movement path to a video you can let the

movement video automatically rotate along the path. This function is only

available in AquaSoft ® SlideShow Ultimate.

Fill On = Background gets a color filling when display size of the
video is reduced.

Off = Background doesn't get a filling and the previous object
"looks through". For images inside collages or Picture-in-
Picture effects it has to be Off.

Automatic = The slideshow sets filling to On automatically for
images /videos/collages in the first track. If you move an
object to the second or a lower track filling will be set to Off.
This way Picture-in-Picture effects can be created quickly. If
you want to the value to remain select it from the drop-down
box.

Transition Here the Transition can be set or also deselected. For that
purpose, in the drop-down list there is None as the first
option. With the Adjust button, the transitions can be
configured. You can also obtain a preview of all transitions
there.

=/ ¥olune

Yolume: 1100 % .

|¥| Fade background music {Settings)

Here you can determine if the background music should be faded out when the video is played back.
If the video does not have its own sound, but perhaps a noise has been recorded, set the volume of
the video to 0% and remove the check mark beside Fade background music.

Transparency
Animated transparency is described in the design options under Animated transparency.
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3.4 Sound

With a Sound object the following settings are possible:

Object Settings = B !

|Dbject settings
[#] Show object
Duration: (200,51 sec 3 |

[¥] se default duration (Settings)

[¥] Fade background music {Settings)
=l Replay behavior

0,00 sec :_!

|
o

Start position:
0 Adijust display duration to sound duration
) Continue sound after set duration

") Fade sound after set duration

. i.'f:l
ni ([D0sec 2|

|iﬁ] 5-:-un§|
| = Sound
O1|MedisiMusiclArtist|01-Titlen 1, wma [
|; & Record | Duration: 03:19.904 |ﬁ|
= Yolume
Yolumne: 100 % 2 |
R

iD.'I,Meu:ha'l,Mu5|c'l,.ﬁ.rt|st'l,D‘3-T|tIeD‘3.mp3 I

b

|! ,53‘ Record |I

Volume

Fade out background music

Play back the full length of
the sound

Continue to play the sound
after the duration set

Fade out the sound after the
duration set

With the folder icon you can insert or remove a music file. The
track selected is shown on the left next to the icon.

Plays back the music file

Opens the Sound Wizard. With this you can record a
commentary for the image via a microphone connected to the
PC. You can find more on the Sound Wizard here.

Displays the volume at which the sound is supposed to be
played back.

If this option is enabled, the background music is faded (volume
decreased) when the music file is played back.

If this check mark is selected, it means that it plays back the
full length of the Sound object.

With this option the sound can receive a shorter exposure time.
The sound is then simply played on into the next images until it
has come to an end.

Should you wish to only play back the sound for a certain period
of time and then end it, you have to select this option. Under
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Duration you can set the fading out time.

The volume of a sound object can be controlled individually. You will learn more about this in
chapter Custom volume settings .

Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ®
! SlideShow does not support the use of music tracks that are encrypted with DRM or
- similar methods.

3.5 Collage

With Collage objects you have the following possibilities for settings:

Object Settings m|onox
|Dbject settings
[#] Show object
Duration: i!-S,DD sec :_!

[¥] Use default duration (Settings)
¥ Leave in place after replay

D Cifral B

[= Title

I=I Transition

Eﬁanm kransition - ' i .C\djust | =
E|-Ba|:kgr|_3_|_.|__nd .

Fil [Automatic o, < | @

Fill color: [E

[= Position

Aspect ratio:

Alignment:

"I Rotate in direction of movement

Image
Title Here you can enter the title for the collage. It serves for a
better overview in large slideshows.
Aspect ratio Images have an aspect ratio which is comprised of the height

and width of the image. If a created collage differs from the
aspect ration of the slideshow you can here decide how to
display the collage.
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Keep: The collage retains borders when being played back.

Crop: Parts are cropped from the edge of the collage until the
collage fits into the correct aspect ratio without edges
emerging.

Distort: The collage is inserted into the aspect ratio of the
slideshow, whereby a distortion of the image takes place.

Alignment Determines the position of the Collage on the screen.
Rotate in direction of If you assigned a movement path to a collage you can let the
movement collage automatically rotate along the path. This function is

only available in AquaSoft ® SlideShow Ultimate.

Fill background On = Background gets a color filling when display size of the
collage is reduced.

Off = Background doesn't get a filling and the previous object
"looks through". For images inside collages or Picture-in-
Picture effects it has to be Off.

Automatic = The slideshow sets filling to On automatically for
images/videos/collages in the first track. If you move an
object to the second or a lower track filling will be set to Off.
This way Picture-in-Picture effects can be created quickly. If
you want to the value to remain select it from the drop-down
box.

Transition Here the Transition can be set or also deselected. For that
purpose, in the drop-down list there is None as the first
option. With the Adjust button, the transitions can be
configured. You can also obtain a preview of all transitions
there.

Transparency
Animated transparency is described in the design options under Animated transparency.

3.6 Chapter

Inthe Object settings of the Chapter only a section name can be specified. This serves to provide
a better subdivision of your show. This chapter name will be loaded into SlideShow-Manager
later,provided it is installed. The chapters can thus later be selected individually in a CD/DVD menu
and played back.
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3.7 Particles

The Particle object shows your images in a minimized form and moves them on the screen.

This feature is only available from <%PRODUCERPROGRAMNAME_R_ORIG%>

ld Premium.
L

Inthe Object settings of the Particle object you can adapt the representation to your wishes.

| .F‘articin-e.

= Images

| ot Media\Imagestimg_4795551 . pg IT:ﬂ
| CviMedialImagesiing_1930704.jpg =

| O\MediaiImagesimg_S009631.jpg | |'__u‘_
= Particle

Direction: [z70,00° * | tangle)

Speed; ID,DD : {Travel/second)
Particle size: jtooo 2 . (% of image size)
Mumber of particles: 2E| =

Mowvementk: | Sinus waves =
Strength of ;i'ﬁ;t"j' : Unit

maosermnent: L

Frequency of 0,50 - 1 Unit

masvement: Ry ST

::E] Inserts additional images into the Particle object.

E] Removes selected images from the Particle object.

Under Direction you can set in which direction the

Direction: (270,00 % | {Angled ) !
e particles disappear.

Directions:

0 degrees = the particles move out of the
image towards the right

90 degrees = the particles move out of the
image towards the bottom

180 degrees = the particles move out of the
image towards the left

270 degrees = the particles move out of the
image towards the top

You set the pace of the movement under speed. The
higher the value is, the faster the particles fly over
the screen. A value of 0 means no speed. The

Speed: [to, o0 2| (Travellsecond) |
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particles won't move.
BT e s 10,00 = | (% of image size) | Here you determine the size of the particles. The
size will be calculated based on the size of the

Position frome in Layout Designer. If the
Position frame takes up the full in Layout
Designerand Particle size is set to 10% then
the Particles will be 10% of the size of the
Position frame. If you reduce the size of the latter
the Particles become smaller, accordingly.

e =] | With_ tlhe ntl]mber of particles, you set the quantity of
partlc es snown.

Here you can select an animation for the particles.

Povement; Sinus waves - I

Strength of 0,00 = | Unit | Here you set how strongly the movement should be
movement: carried out. The higher the number, the stronger.
Frequency of l0.50 = Unit | The frequency specifies how often the movement is
movernenk: e Bl

carried out. The smaller the number, the lower the
number of movements.

The Particle object can in addition also be provided with movement paths. In AquaSoft ®
SlideShow Ultimate you can even rotate the Particle object.

4 Controlling the slideshow

4.1 Automatic course

It is standard for the images in a slideshow to be automatically played back in sequence. In that
respect, you determine in the Object settings of the Slideshow objects how long an image, text
or collage is shown and when to switch to the next object.

No special settings are necessary to accomplish this with AquaSoft ® SlideShow.

4.2 Manual control

Should you wish to move on manually during the show, you can configure the SlideShow Player
accordingly in the SlideShow settings.

The SlideShow settings always refer to the current show open.

d

From the menu bar you can open the SlideShow settings using the
can also open the dialog using Slideshow -> SlideShow settings.

icon. Alternatively you
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- Slideshiom fow
Transitions
Muzic: settings

Background muszic iy Very good =

i Descrption

Loga
- SlideS how-Player

“ Standard Player (Directs) Az 16:9 [Blu-ray, DWD, wide screen manitar] -

Confgus player

Via the Basic settings you can access the Player configuration directly.

127
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| = Slidzshow
Main gettings

Standard Player (DirectX)

- Slideshaw flove

= Transitions

= Muzic: settings

= Background riusic
= Description

Loga

= SlideS how-Player

& Standard Flaper [Direct)

automatic fade-in and -out = 5

The Start paused option switches the show over to being continued manually. You can then
continue the show using the cursor and scrolling keys.

If you activate Forward/back per mouse click in the dialog, you can continue your show by
clicking the mouse.

4.3 Automatic and manual course mixed

With AquaSoft ® SlideShow it is likewise possible to continue parts of the slideshow manually and
let other parts play back automatically. You can alter this as you please.

In the Toolbox you will find two Slideshow objects for this purpose:

Copyright © AquaSoft GmbH 1999-2015



Controlling the slideshow 129

Image effects Text effects Movement paths

Slideshow objects Fade-ins Fade-outs

H A

Rectangle, Stripes  Text Mask

soft
= _Controlling —

Llijid

Pause Flay

Custom objects — =

These two objects make it possible to switch between continuing the show manually and letting it
run automatically. By double-clicking or by drag-and-drop you can insert the objects into your
show.

If you, for example, insert the Pause object behind the 3rd image, the show will stop before the 4th
image and wait for you to continue using the keyboard or mouse.

The manual replay can be interrupted again with a P/ay object. For that purpose, insert the Play
object at the point where the automatic course is desired.

Artificial pause:

You can also insert a Play object directly behind a Pause object. Thus, the show will be stopped at
the image before the Pause object and, as soon as you continue, the show continues to run
automatically.

You can also use the Space bar to pause the show during replay. When you hit thr Space bar again
the show continues.

o If you convert your show into a video DVD, this function of the two objects is lost. To
pause a video DVD, you have to use the pause key on the remote control.

4.4 Repeating the slideshow infinitely

From the menu bar you can open the Slideshow settings using the J icon. Alternatively, you
can also open the dialog via Slideshow -> Slideshow settings. Under End of slideshow you
can enable the Repeat current slideshow function.
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[ Slideshow

Fl . =T

= Muzic: settings
= Background riusic

= Description

L-LDgD
= SlideS how-Player
“ Standard Player [Direct<]

If you convert your show into a Video-DVD this functionality will be lost. If you create
your Video-DVD with SlideShow-Manager you can there activate the repetition of the of
replay.

5 Export options
5.1 DVD-Player

For the DVD player your show must be converted into a video and then burned as a video DVD. This
function is provided by the Video Wizard and by SlideShow-Manager. SlideShow-Manager can
even burn multiple shows on one DVD that can then be selected in from menu.

Video Wizard
With the Video Wizard you can quite easily burn your show onto a DVD/BD and thus play it back on
the DVD/BD player. Under Wizards you can open the Video Wizard.
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28 Video Wizard

SVCD Video-CD from file

a Y e ¥ B
: <
: . .

AVI MPEG WebM

Rz

MEV Anim, GIF Frames

I Cancel | r Bac | | Next >

Blu-ray

If you have a Blu-ray burner, use this option in order to directly burn a Blu-ray.
Resolution: 720x576

AVCHD

If you have a DVD burner, you can burn in HD-quality and load the disc into the Blu-ray player. Select
this option to create an AVCHD for your Blu-ray player.
Resolution: 720x576

DVD

Creates an MPEG 2 video and burns it onto a DVD as a video DVD.
Resolution: 720x576

SVCD

Creates an MPEG 2 video and burns it onto a CD as an SVCD.
Resolution: 480x576

VvCD

Creates an MPEG 1 video and burns it onto a CD as a VCD.
Resolution: 352x288

Select the D VD option. Only use VCD or SVCD if you have a CD burner and no DVD burner. In this
case we recommend SVCD. It has a higher resolution than a VCD and thus thus resultona TV is
better. Then click Next.
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28 Video Wizard
Burn as DVD (16:9, PAL)
@) PAL A 16:9 DVD is being created because your show has this
e aspect ratio.
(] NTSC

Burner: I: (HL-DT-5T DVD+-RW GHTOM - A101) change...
Writing speed: 1 x (176 KB/s)
Medium: No medium (approx. 45,3% MB required)

Bitrate: i 8,00 Mbitfsec

| |smoother video by Interlacing
';CorrectT\n' borders (0,00 %)
|+ Save created video to:
P: \Media\Shows\slideshow.mpqg =

| |don't burn, just create video

Cancel . < Back Mext =

In the settings dialog you can set various options. The TV border correction is required if the
television frame covers up the visible area at the edge. E.g., the first character could be missing or be
displayed incompletely from text that starts directly at the edge. Or the top or bottom of the
characters could be chopped off. These settings depend on the TV and manufacturer.

The Video standard is automatically set to PAL, the European video standard. NTSC can also be set
if you need the American video standard. The aspect ratio is automatically adjusted to the aspect
ratio of your slideshow. If you have created a 16:9 show, PAL (16:9) is automatically set. With a 4:3
slideshow PAL (4:3)is selected. A 4:3 slideshow can not simply be burned as 16:9 show, and vice
versa.

Before the DVD can be burned, it must first be converted into a video. An *.mpg-file is created in the
process. This needs to be saved to the hard disk prior to the burning process. You can decide the
storage location and the name under Video file. You can also choose to activate the option to delete
the video file after the burning.

Then click Next and Create video. The process of the video creation can require some time.

If you want to burn more than one CD/DVD with your show you don't need to repeat the process of
the video creation for each one of them.

You can access the Burn video on CD/DVD option in the Video Wizard.
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R Video Wizard
| Burn
- = S /1
=, oy \L | ‘..( ! —
0) (Of &) )
Blu-ray AVCHD DVD SVCD Video-CD
Video output
- ’
MP4 MZTS WMy AVT MPEG WebM
2 4k B =
MOV MEV Anim, GIF Frames
f Cancel | " Blac | | Mext >

Here you can burn a video file already created (mpg video), which you have saved on your hard disk,
onto a CD/DVD.

28 Video Wizard

I/ Burn from file

File name: P:Wedia'ﬁhows\ﬁlideshow.l‘tﬂs _{Ha

(@] AVCHD-Disk 115 \ideq wil be burnt as.

(1 Bluray

Burner: I: (HL-DT-5T DVD+-RW GH7OM - A101) change...
Writing speed: 1 x (176 KB/s)
Medium: No medium (approx. 0 Bytes required)

-l Extended
| H.264 ] AVC [ MPEG-4 AVC / MPEG-4 part 10, 1920x 1088 with 50 frames/ =
B Audio (H
- ATSC AJ524 (AC-3), 48000 Hz, Stereo =
4 | = . 4 3
i Cancel | ' = Back

Specify the relevant mpg file and what type of video is concerned.

SlideShow-Manager

In AquaSoft ® SlideShow Ultimate you can also use SlideShow-Manager to burn your CDs/
DVDs. It allows to burn multiple shows on one DVD and to create a DVD menu.

You can open SlideShow-Manager from the Wizards menu.
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ject
5 Do Show 1

] High-guality preview
[ERRC P ™ Menu | EE ¢
-
=) AquaSoft
. z - z —
AquasoftPremium AquasoftUltimate ‘wide-screen Introduction
I= Unabtrusive backgrounds
= | S -
i | =i .\3 F
AltPapier Bottom of the sea Bluge veil Vellow veil Gray veil
Ay g S ] =
I -
Gresn veil Lilac weil Red veil Waves = |
Additional templates on the Internet | Mew template |I b Edit template |I

A

Select a template for your DVD menu and adjust the individual settings for the menu.

Under DVD-Menu specify aspect ration and video format.

i Templates [ Menu [y customization & pcMenu @ DV‘DEHU |
Aspect ratio

@ 43

188

Video Format

@) PAL
_ NTSC
Play
| When using "Play all” restart after last title

By clicking the —j button a dialog for burning the shows opens. Select Video DVD.
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1] Export project El
Burn
' Burn project
Burner: I; (HL-OT-ST DVD+-RW GH7ON - A101) Burner settings
Writing speed: 1 x (176 KB/s)
Export
!C:ee te VOBs vi Extended...
Target folde | k] |
Memory space
e o oo
700 MB 4,3GB 7.8GB
Total duration: 2:40 Required space on the C0/OVD: ca. 122,07 MB.
e No storage medium in drive.
Chapter: 1
Cancel < Badk

With Burn project you create a video DVD. Click "Next"and "Export project”.

135

You can find an extensive description of SlideShow-Manager in the help files of SlideShow-

Manager. You can find it under "Help"

52 PC-Show

in SlideShow-Manager.

Your slideshow can also be played back on a different PC, on which AquaSoft ® SlideShow is not

installed.

The CD/Archiving Assistant will assist you in burning your slideshows with all the data to a CD/
DVD or archiving them on the hard disk.

Under Wizards you can open the CD/DVD and Archive Wizard.
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2R CD/DVD and Archive Wizard

Select task

l o Create and write SlideShow-CD I
reates a - that is playable on any Windows-PC,

This CD indudes all original files {mages, music etc.) and the
SlideShow-Player. An installation on other computers is unnecessary.

Mote: This CD is not supported by DVD-Players, Use the Video Wizard for that
purpose.

| Archive slideshow, prepare CD/DVD or distribute slideshow

Copies all les neede L or creates a ZIP-file.
Everything is included: images, sounds, background music, SlideShow-Player
B

This way you can extract the slideshow e.g. to USB-Sticks, external hard
drives. And it is still possible to burn it to CDfDVD afterwards,

Click "Next” to continue.

Cancel _ < Back

After selecting the task, click Next.

Creating and burning a slideshow CD:

2R CD/DVD and Archive Wizard

Setﬁl'm_

Slideshow-CD title;
|Slideshow

“|Burn al necessary fonts

| Protect images from access

Protects your images so they cannot be accessed from the outside.
Attention: Mever delete your original images and slideshows! When protected,
the files can only be played with SlideShow-Player, but cannot be extracted.

: create I50-C0D-mage only, don't write

CD/DVD/BR-Burner settings | Select temporary folder

Click "Mext" to continue,

Cancel < Back

Specify a title for the CD/DVD. This title is used as the name of the CD/DVD.

Should you use fonts in the case of which you are not sure that they are installed on other PCs, you
can also burn them onto the CD/DVD.

Protect images from access:

Should you wish to pass on the CD/DVD, however not permit access to your images, you can have
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your images protected. This function is not suitable for archiving, since this show can no longer be
edited. It can only be played back. It is no longer possible to restore the images. You should not
delete your original images from the hard disk.

If you only want to create an ISO select the respective option. In this case the show will not be
burned.

Click Next to start the selected process.

Archiving the slideshow, preparing the CD or passing on the slideshow

This option enables you to save all data (ads file, images, music) in a common directory. This option
is also very well suited to archival storage. In this way the slideshow can also be saved on external
data carriers (hard disks, USB sticks ...).

28 CD/DVD and Archive Wizard
Create

‘You made all necessary changes. Click Start to beqin the process,

[ start

Cancel

In order to save disk space, you can pack all the data into a ZIP archive.

If you use fonts in the case of which you are not sure that they are installed on other PCs, you can
copy these as well.

You should copy the Slideshow player in order to be able to play back the show on computers on
which AquaSoft ® SlideShow is not installed. Without this player you cannot otherwise play back
the show.

Click Next and then click Start. Now all necessary data for the show will be copied into the folder
specified or combined into a ZIP archive.

5.3 Additional video formats

With AquaSoft ® SlideShow Premium and AquaSoft ® SlideShow Ultimate you can convert
your shows into further video formats.

For that purpose, select the User-defined video option in the Video Wizard. In the dialog you can
now select additional formats under Video format.

Copyright © AquaSoft GmbH 1999-2015



138 AquaSoft SlideShow - Help

Check in advance with which codec videos have to be created, so that your DVD player plays them
back (Operating Instructions). Then check whether this codec is installed on your PC. If not, you have
to install the codec.

Video-Einstellungen

AVI (video for Windows)

MPEG (VCD, SVCD, DVD)
—— MY (W

Auflésung: iﬂdﬁarter-mm-x:ai;lng?-%rﬁggj-lajg'ﬂ- JE e P
Seitenverhaltnis: ol 13 B:H)

Framerate: 25,0 @ fps

Komprimierung: %:I_-Inkom!;lr.ia'l-i.e_rt = |

Komprimierung: | i T |

. Abbrechen < Zuriick | | Weiter =

AVl-video
AVl is a widely used video format and will be played by newer DVD players.
Set the desired resolution and under Compression, you select the appropriate codec.

Please check first which codec has to be used for the creation of these AVI-videos so that your DVD-
player will be able to play them (Operating instructions). Check to see if this codec is installed on
your system. If not, you must install the codec. AquaSoft ® SlideShow doesn't provide any codecs.

In our FAQ you can find further informationen.

Please note that an AVI video should not be larger than 2 GB. Most players will not play
Id a large AVI movie.
L

Not every codec supports all resolutions.

WMV-video
This format is only available in AquaSoft ® SlideShow Ultimate.

For the creation of a video in WMV format, you should install a recent version of Windows Media
Player.

Using the WMV format, you can use a very high resolution for the video. The finished video can be
played with Windows Media Player. Currently, only a few DVD players support this format.
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5.4 Archiving a slideshow

Often you have invested a lot of time in a comprehensive and sophisticated show. As to not lose your
work in case of a hardware crash you can save the complete show with all containing files (images,
music, comments).

The CD/DVD and Archive Wizard offers you the opportunity to burn the complete show with all
the data onto a CD/DVD or export it to an external drive.

This procedure is explained in the PC Show section.

5.5 Additional export options

There are other export option that you can read about in chapter Export Wizard.

6 Image editing
6.1 Integrated image editing

It is our goal to provide you with all necessary tools in one single program, the AquaSoft ®
SlideShow. Therefore we integrated image editing functionality that allows you to enhance your
photos for the slideshow. Of course there are specialized image editing applications that go far
beyond the capabilities of the image editing module in AquaSoft ® SlideShow but it should be
possible to solve the most important tasks inside the program.

Rotation

+90°

e [N RN o
< o [ e |38 e |

‘E Expasure auto m’rechm‘ ‘ Brightness /Contrast ‘

| rstooamcomecion || [ Ganma |

|H Color correction HH Colorize ‘

| Reset |
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Use the right mouse button to click on the image and select the option Edit image. There are
functions to crop and rotate images, for color correction, adjustment of brightness and contrast and
some filters like blurring. By using the magnifying buttons (just like in Layout Designer) you can
adjust the size of the display of the image or image segment.

None of the provided image editing functions modifies your original image.
ld‘ The modification only affect the display of the images inside the slideshow.
L

6.2 AquaSoft ® Image effects

The Image effect editoris only available in AquaSoft ® SlideShow Ultimate.

<

With Image effects graphics can be optimized or spiced up. From a simple shadow over pleasing
frames and collages to branched effect chains (Multiplicating) many things are possible. Complex
effects are combined from different basic modules and allow non-destructive image editing (the
original image always stays untouched).

When you click on an image in the Image list or Timeline you can select the menu item Edit
image.

Effects

D6d <+ 0

Tools

Under Effects the Image effect editor opens.
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[=_:]
]
o 3]

With the help of the Image effect editor those effects can be assembled and saved to be reused
later. Let's just start with a shadow effect and improve our skills to create a "self-border" afterwards.
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6.2.1 Asimple shadow

You need only a few clicks to assign an unobtrusive drop shadow to an image.

Effects
W] = UG
. Blur

Border
Brightness/Contrast
Collage
Color correction
Coler filling
Colorize

Contour

Crop

AL Effects =
Duplicate
Object settings Exposure auto correction

Frame

Gamma

Glow
Histogram
Mask

Mirror

Script

Shadow
Sharpen
Transformation

Transparency

Sub-effects are simply added via the menu. Thus add the sub-effect “Shadow”.

Note: The number of available sub-effects in your version of the application can differ from that in

the image above.

Now you can see that the shadow has been added to the previously empty “effect list". On the right
side of the dialog appear controls that let you adjust the settings of the shadow to your liking.
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I Eaitimage effects oo s
DeaE & o w) AL L
v B

Distance: 0,20 am =t

£ o 10 - s

Angle: 45,0 ° x
Color

Finished

oK I Cancel

At the bottom-left the shadow effect is showcased on the butterfly graphic.

Each sub-effect can have very different settings. How each of them affects the result you can find
out best by trial and error. In our specific example the offset of the shadow from the original image,
the angle of the incidence of light, the strength of the blur and the transparence of the shadow can
be specified.

That's all there is to it. Clicking OK applies the shadow to your image. Of course, all the settings can
still be edited later. The original graphic is never changed.
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6.2.2 A"self-border" using multiplication and transformation

We want to achieve an effect that used the image itself to create a semi-transparent border. The
result will look similar to the picture below:

The basic idea of the solution looks like the following:
1. Enlarge the image and assign semi-transparency to it

2. Overlay the semi-transparent image with the original image

Here an important functionality is utilized that is also crucial for the creation of many other complex
effects: Multiplication.

To achieve 2. at all a copy of the original image needs to be stored to be able to overlay the image
that might already be changed by previously assigned sub-effects. The multiplication effect allows
exactly this. By using it the normally flat list of effects will become a tree, because the multiplication
effect can have child elements. The sub-effects can be moved around via drag&drop.

All effects that are children of the multiplication effect are "served" with that state of the image data
source that has been current at the branching point, no matter in which way and how much a
different child element has changed the image.
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.=Ediﬁmageeﬂeds E
Dol & o R YY)
= [#] Duplicate

o v

S E| Transparency
“[#] Transformation

Object settings

dat o i e

|Scale -

m

Zoom infZoom out

E\(| Relatve : in % "' incm
% [osom 2|

o
¥ 080em 3|

Finished

Here you see the completed effect: The multiplication effect got a transformation assigned as sub-
effect that enlarges the image by a few millimeters. To that the transparency effect is assigned to
make the image semi-transparent.

Now we need to use a little trick: To display the original image again we simply add a second

transformation to the multiplication. Only this time no offset, rotation, etc. is set. So the image stays
the same.

Note: Child elements of multiplication effects can have child elements themselves.
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7 Wizards
7.1 Export Wizard

The Export Wizard will assist you in burning your finished slideshows onto a CD/DVD or archiving

them, or also saving them as a video, to the hard disk.

You can access the Export Wizard via Wizards -> Export Wizard.

Export Wizard IEI
Select an output format:
=l
Photo frame
SlideShow-Manager WebShow
i Cancel . I Open !
Burn onto CD/DVD
DVD.

Select this menu item if you would like to record your show onto a CD/

PC/Data

Select this option if you would like to archive your slideshow and all associated data (images, music)

on the hard disk or save it to the hard disk as a video.

If you would like to burn your show onto a CD/DVD, click Burn CD/DVD and then click Open (or

double-click CD/D VD).
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Export Wizard =

Select an output format:

! Burn HD video  Burn existing video Burn PC-slideshow
i e} I

Video-DVD with
menu

Cancel |

§

You now have several possibilities.

For the DVD player:
Video VCD

Creates an MPEG 1 video and burns it onto a CD as a VCD.
Resolution: 352x288

Video SVCD

Creates an MPEG 2 video and burns it onto a CD as a SVCD.
Resolution: 480x576

Video DVD

Creates an MPEG 2 video and burns it onto a DVD as a video DVD.
Resolution: 720x576

Burn a video already created
Should you already have created the video, you can, in this way, burn the video onto a CD/DVD.

You can find out whether your DVD player plays back VCD and SVCD from the operating manual.

Note:

If you encounter difficulties replaying a burned VCD/SVCD/DVD on a DVD-player it can help to
reduce the burning speed in the settings for the CD/DVD-burner and/or to change the brand of the
CDs/DVDs.

You can find additional information in chapter DVD-player.

For the PC:
Burn a PC-slideshow:

With a PC slideshow, the images are not converted into a video. This CD/DVD can only be placed
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back on the PC (Windows 2000/XP/Vista). These CDs/DVDs are also well suited to archiving a show,
since all pieces of music and images incorporated in the show are copied onto the CD/DVD.

Should you only wish to save your show on the PC, without burning it, you can open PC/data in the
first step in the Export Wizard.

Export Wizard =

Select an output format:

4 & 9

! Create video Archive Compile
PC-slideshow PC-slideshow

Create PC-menu

§

Cancel |

Here you have the possibility of archiving/putting together the show for the PC or converting the
show into a video. Additional information can be found in the PC Show section.

The grayed-out functions will become active only when you install other products by AquaSoft that
come with the respective plug-in.

The Export Wizard accesses the relevant wizard, according to the task selected.

! For output for DVD-player or for video creation it calls the Video Wizard.
- For output for PC it opens then CD/DVD and Archiving Wizard.

7.2 SlideShow-Manager

The SlideShow-Manager allows to burn multiple shows to a CD/DVD. It creates a CD/DVD menu
that allows to navigate to a certain show.

AquaSoft ® SlideShow Ultimate already contains SlideShow-Manager. If you're using
SlideShow Premium and want to use SlideShow-Manager you can purchase it as a separate

product.

You can find an extensive description of SlideShow-Manager in the help files of SlideShow-
Manager. A short description is included into this manual in chapter DVD-Player.
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7.3 Sound Wizard

Using the Sound Wizard you can record spoken commentaries and noises with your images using a
microphone connected to the PC.

You will find the Sound Wizard in the menu under Wizards.

’ Sound-Wizard

Sound:

|| Object: shutterstock_110496275.30g
T A

|G|

Length: ?

Recording device:
Front Mic (Realtek HD 2J8d
m

[ T R R T B T R B |

Low Loud

‘ ‘ Record ‘

I < Previous | | Fla | | Mext = | | Close |

| Cancel | = Back | | Mkt |

You can save the resulting files in the slideshow directory or in a separate directory.

Under Record settings you can decide the settings with which the commentaries should be
recorded.

Then click Next.

’ Sound-Wizard

Object: shutterstock_110496275.jpg Sound:
S D:\Media\Showsisw_00 (5 |

Length: 0:05

Recording device:
Front Mic (Realtek HD 2J8d
m

[ T R R T B T R B |

Loud

Low

| < Previous || Close |

Cancel | = Back | | Mkt |
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Now all the images in the show with which you can include a commentary will be shown to you in
sequence. To do so, simply click Record and then speak your commentary on the relevant image.
Should you make a mistake while recording, you only need to re-record the commentary for the

selected image.

&R Sound-Wizard

Object: shutterstock_110496275.jpg

‘ ‘ Record

D:Media\Shows sw_0t

Sound:

Length: 0:05

Recording device:

Front Mic (Realtek HD 2J8d

Loud

| < Previous

Play

Mext =

Close |

| Cancel

L\Y M | p——

With Play you can listen to your recording. In order to get to the next image, click Next. Once you

have finished recording, close the Sound Wizard.

The Sound Wizard automatically matches up your images with the commentaries recorded. You can
find the recorded file in the Object settings of the relevant image. The recording can also be played

>
back here, using the ‘, button.
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Object settings

Object settings

[+ 5how object
Duration: 55,66 sec :

Image | i Text ill] Sound @ Transparency

= Sound
;D: \,I'ﬂeu:ii;aHSHnu\'s'os".r\'_DDDD.'A'av = D,
&' Record ': Duration: [6303:20.567 | [ |
IEI mlm -
Volume: 1100 % s
w.f Fade background music (Settings)

Start position: 0,00sec %
{ ! Continue sound after set duration

|| Fade sound after set duration

Fade-out duration::d,uud sec : ]

The Sound Wizard can also be started directly from the Object settings of an image. For that
there is the Record button.

@

7.4 Import Wizard

With this wizard you can import your images from a scanner or from your digital camera, as long as
these devices respond to the TWAIN32 interface. The images are saved and included in the Image
list. They can either be improved with the editing function immediately or later.

The length of the image is automatically adapted to the length of the commentary.

You can access these under Wizards -> Import Wizard.
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28 Import Wizard

Image settings
Directory to save images to:

In what format do you want the images to be saved?
pg; *.jpeg Selected format:
| TrueVision Targa (*.taa) IPEG (*.jpa; =jpeg)
| Windows Bitmaps (*.bmp) S =
| Format options |

Some image formats have additional settings,
like compression etc, You can change these
settings in Format Options.

.r\?‘ Add images to slideshow
|: Confirm automatically

I Select scanner /camera

Click "Mext” to continue.

i Cancel ' < Badk

Specify a Target directory in which the images should be saved. Selected the desired file format
and, if necessary, adjust the Format options.

If the images are supposed to be directly included in the Image list of the slideshow, enable this
function.

Then select the scanner or camera.

Next click Next and then click Start. Your images are now imported.

7.5 PowerPoint Wizard

With the PowerPoint Wizard you can import your PowerPoint presentations into the slideshow. A
prerequisite is that MS PowerPoint (Version 8 or later) is installed on your PC.

During import the individual slides are saved as images. All animations and effects will be lost in the
process, however.

You can start these under Wizards -> PowerPoint Wizard.

Specify the File name of the PowerPoint file to be imported.
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28 PowerPoint Wizard

Cancel |

PowerPoint Wizard
With this wizard you can import MS PowerPoint-Files (*,PPT) into DiaShow.
Each slide will be saved as an image {animations etc. will be lost).

It is required to have M5 PowerFPoint (Version & or higher) installed, because
DiaShow cannot read the files directly. After importing MS PowerPoint is not
needed again.

Filename of the PowerPoint-File you want to import:

Click "Mext” to continue,

Then click Next.

153

Specify a Directory in which the images should be saved. You can use the slide name as the file
name or use the form Imagexxx.

28 PowerPoint Wizard

Cancel |

File settings

The PowerPoint-Slides will be saved as image files, Pleaze enter the name and
folder to save the files,

Target directory:
DUPRTY

Find file names:
19 Use PowerPoint-Slide name

[} Use names in the form “Imagexc”

Click "Mext” to continue,

< Back | Mext =

|

Click Next.

Now you can set the image options. Select the desired resolution and the image format. Under

Format options you can configure additional settings relating to the image format.
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28 PowerPoint Wizard
Image setlingf__
In what resolution do you want to save the slides?
(| BH0x480 _ | Custom resolution;
[ | B00x600 Width: [1024 =]
(0] 1029%768 : il
() 1152x864 REgRESSN/SE - |
1 12801024

| 1600x1200 || Antidliasing

In which format do you want to save the slides?

g Selected format:

|TrueVision Targa {*.tga) JPEG (*.jpa; ®.jpeq)

Windows Bitmaps {*.bmp) r . -
| Format options |

Click "Mext” to continue,

| Cancel | < Back |

Click Next and then click Import. The slides are now converted into image files and inserted into
your slideshow.

7.6 Video Wizard

In order to show your show on the television, you can create a CD/DVD for the DVD player with the
Video Wizard. You can access this under Wizards -> Video Wizard.

An exact description of the wizard can be found in the DVD Player section.

7.7 CD/DVD-and Archiving Wizard
The CD/DVD and Archiving Wizard will be explained extensively in chapter PC-Show.
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7.8 Photo Frame Wizard

Using the Photo Frame Wizard you can transmit your slideshows as individual images or as a
complete video on a digital photo frame.

= Photo Frame Wizard

Photo Frame Wizard

The PhotoFrame-Wizard allows you to transfer your slide show to & digital photo
frame.

How do you want to transfer the show?

| Transfer frames

Adjusts all images to the size of you photo frame and transfers them. Captions
remain intact, but animations and transitions do not.

|| Transfer slideshow as video
If you frame supports videos you can use this option to convert the slideshow

into a video (MIPEG) and to transfer it to the frame. The slideshow will be
replayed on the frame induding sound, music and all animations.

Cancel

Export as separate images

Firstly, specify the resolution of your frame. If you are not sure what resolution your device has, you
will generally find details in the corresponding manual or on the manufacturer’s web site.

= Photo Frame Wizard
Resolution
Which resolution does your photo frame have?
|& Pre-defined resolution:
R T
|| Custom resolution:
= [ =

If you're uncertain which aspect ratio is supported by your photo frame, please
consult the user manual.

Cancel ' < Back

Text can be included with your images, text animations will be dropped, though. The text becomes a
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static part of the image.

If your images have a different aspect ratio than your photo frame you can use the option Crop
images to display them full frame.

= Photo Frame Wizard

Cancel

Flease select how the wizard shall process your photos,

| Assume image captions
If you specified captions for your images the captions will stay intact.

Images that don't completely fitinto the frame will be cropped to become
format filling.

[ Cropimages

Image quality: |90 % ;

The higher the guality is the higher are the space requirements,

< Badk

In the last step select the storage location for your images. This can be the photo frame, a USB stick

or a memory card.

Click Start. The wizard now computes your images in accordance with the predetermined settings
and copies them into the target directory.

= Photo Frame Wizard

Cancel

Transfer

There are different options to transfer the slideshow to the frame,

» per USH: Directly connect the frame to your PC using & USE cable, The frame
will get its awn drive letter assigned. Select it in the field below.

» per memory card/USB stick: If your frame has a plugin position for a
memory card (e.g. S0 or CF card) or a USB stick then plug one of those into your
PC. You might need a separate card reader for memory cards. Select the drive
letter of the card or the stick in the field below.

Target (memory card or frame):

Start
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Transmitting a slide show as a video

If you want to transfer the whole show as a video please verify beforehand that your photo frame
supports Motion JPEG videos.

This information should be provided in the manual of the photo frame.

28 Photo Frame Wizard
Photo Frame Wizard

The PhotoFrame-Wizard allows you to transfer your slide show to a digital photo
frame,

How do you want to transfer the show?
{ Transfer frames

Adjusts all images to the size of you photo frame and transfers them. Captions
remain intact, but animations and transitions do not.

u {Transfer slideshow as video:

If you frame supports videos you can use this option to convert the slideshow
into a video (MIPEG) and to transfer it to the frame. The slideshow will be
replayed on the frame induding sound, music and all animations.

Cancel | B { Mext =

In case your show has a different resolution than your photo frame you can now activate the option
to correct the aspect ratio and fill the remaining borders with black. This way the images won't get
distorted. You can also decide to integrate sound and music into the video, which only makes sense
if your photo frame is able to replay them.

28 Photo Frame Wizard
Video Format

The wizard can process the photos in different ways.

|| correct aspect ratio with colored borders

If the video doesn't fill the format if your frame black borders will be added, so
that the video won't get stretched unpropartionally.

v’ Integrate sound and music
Hint: Without sound the video will use less space.
Image quality: |90 % :_

The higher the guality iz the higher are the space requirements,

Cancel ' < Back
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In the last step select the storage location for the video. This can be the photo frame, a USB stick or a
memory card.

7.9 Find missing files

AquaSoft ® SlideShow only saves links to your images and music which you use in the slideshow.
Should you move, delete or rename your images. AquaSoft ® SlideShow can no longer access
them. You will then see the following notice in the

Layout designer =T B 4
5185 PP L H- TP T T - Timemark 0,00sec - H
[ ] &) L

() File "data\shutterstock_| 843.jpg" couldnt be found. ]

e bbbl i S ()
b 00:00.000

AquaSoft ® SlideShow cannot retrieve/recover deleted images.

Under you can call the

Copyright © AquaSoft GmbH 1999-2015



Wizards 159

28 Change search path

Find files

In case you moved or renamed your files, and SlideShow cannot find them
anymore, enter the new search path here:

-ii:_: Find missing or renamed files automatically
{ - | Enter new search path directly

| ' Convert absolute paths into relative paths
|| Convert relative paths into absolute paths

Apply action to
{ | Adjust selected entries only

1) Adjust all entries
{ Adjust backaround music (Slide Show Settings)

Here you have several search possibilities.
If you are not sure where the files sought are located now, activate the automatic search.
If you know exactly in which directory your images are located, you can also directly specify the path.

If you want to convert the path from absolute (details of paths are saved in their entirety) to relative
(details of paths are saved in relation to the location of the ADS file) or vice versa, select the relevant
option.

Then specify the entries that should be adapted.
Click Next.

Now select where your images should be sought.
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: = Change search path

Folder selection
Select folders to be searched for missing files.

=t [H] (8 Computer
- [ (i 05 (€
&[] (—a Lokaler Datentréger (E:)
- [ oy Muskk (F2)
- [ g G (G2
F- —a Coding {0}

Cancel | | < Back | .

Click Next and the search starts. Afterwards the results of the search are shown to you.

: = Change search path

Select from the list of found files those files that are to be assigned to the missing
files of the slideshow.

= [¥] img_1330704.jpg
o O:'\Media\Imagesimg_1930704.jpg

Cancel | < Back | | Finish

Click Finish and your slideshow is updated.
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8 Variables

In AquaSoft ® SlideShow there is the possibility of having certain image information displayed as a
text in the image, e.g. the date taken, the file name or the path to the image. This occurs by means
of Variables.

These have to be specified in the format below in the Text field in the Object settings of an image:

Object Settings =R |

|Dbject settings
| [@]Show obiect
Duration: EDD sEC ::l

[¥] Use default duration (Settings)
¥ Leave in place after replay

T TEX':] | Sound | e Tramsparency

=l Fonk

[#] arisl  AbCOEfGH] - i
[=] Style Alignment

AaA =B

=l Text

| a’oFiIename%l

[=| Effect

A SD S Border color:

Anirnation:
!.ﬂ.lphablending ¥ | |; ];:.— Edit 1|

_ Ratation around text _ Show kext with image
Ll center L4

Eehavior along & movement path:

b |

Texk block

In principle, Variables have to be enclosed between two % signs.

Inthe Layout Designeryou will then see the implementation of the Variables.
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Layout designer =T B 4

D b (ke B o o | 0000000

EXIF information on your images can also be included using Variables. In that respect, your image
must contain EXIF data.

You can check this by clicking on an image and then having the meta-data displayed under View -
> Controls. Should these be empty, your image does not contain this data.

You will find a list of all possible Variables in the program under Tools -> Program settings ->
Plug-ins.

E Main set'hngs

5 Plug-ins
 add ﬁles : )
- User interface LT
£ Temporary, fuldey The list shows all available plug-ins. The plug+ns to be loaced are chedked.
'"Languag.e Flug-in File narne: Wersion State
R ona totats ImageVision.plg  C:'Program Files (x86)\AgquaSoft\Dia... 1.0.0.40820 OK
~Record soond DiaShowMana...  C:\Program Files (x86)\AquaSoft\Dia... 8.1.4.40928 OK
. i Default image settings WebShowPlugi...  C:\Program Files (x86)\AquaSoft\Dia... 4.0.1.40820 OK
- Confirmations
: - Sound system
- CD/DVD/BD-Burner
| Automatic backup
El Panels
Timeline
- Storyboard
= Layout designer
= Grid
 Object grid
- Center lines
- Regular
- Default
- Imagelist :mﬁmmmﬂhﬂﬂmmm

after the application has been restarted.

After clicking the Info about plug-ins button a window is opened, in which the Variables are
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listed.

About plug-ins

Variables available: |

= 359

appcopyright
appriame
appversion
aufnahmedatum
aufnahmejahr
aufnahmeminute
aufnahmemonat
aufnahmesekunde
aufnahmestunde
aufnahmetag
aufnahmeuhrzeit
author

autor
beschreibung
capturedate

Close |

You have to scroll down a bit in order to get to the list with the Variables.

9 Settings
9.1 View settings

In SlideShow you can choose from different pre-defined views on the main toolbar an under View. If
you want to add other modules to the current view you can select from the menu under View ->
Controls.

Please have a look at our screencast to learn how to create your own favorite layout. The screencast
is available at the following web address:

http://aquasoft.de/download/flash/edit_view_cast/ansicht_editieren.html

In AquaSoft ® SlideShow Ultimate you can save your layouts under View -> View
management.

9.2 Slideshow settings

The slideshow settings can be individually changed for each slideshow.

Under Slideshow -> Settings you can access the window for the Slideshow settings. You can

also access the settings directly via the —I button in the menu bar.

Basic settings:
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Slideshow settings 3]
(= Slideshaw . &
T pwr— Main settings
Mai 05
Slideshow flow "
. Display
Tiansiions | === =
Music settings A low replay quality can help speed up the slideshow on 2 slow computer.
Background music Feplo L .Ver_u o -

Diescription
£ glidezhow can be played in any resolution. Only the propartions are important. Theyp can

Loga > .
wary with the purpoze of the slideshow.

(= SlideS how-Player
Standard Player [Directx) Azpect ratio: :18 9 [_Blu-ra_f,l, DD, wide screen monilor_] -

Mm-ﬁaver

Configure player

! oK LCancel Help

Here you can change the Standard exposure time of your images, as well as select a Random
playback sequence for your images.

You can adjust the "display quality" according to the performance of your computer here. The higher
the quality the higher is the required performance. This setting is of no importance during the
creation of the video. It concerns the quality when replaying the show using the AquaSoft ®
SlideShow Player. If the "display quality" is too high for your PC this can lead to a jerky replay
experience of your show.

You can likewise set the Aspect ratio of your show here. Should this not correspond to the aspect
ratio of your images, you will get edges or you fit your images into the desired aspect ratio.

For the Standard Player (DirectX) a DirectX 9c-compatible graphics card with at least 64 MB
memory is required. It is also mandatory that you use the manufacturer’s current graphics card
driver!

If you still have an older graphics card or one with little memory please use the Software Player. If
your show is set to use the Standard Player (DirectX) it will be checked if it is possible to use it
with your graphics card before playing the show. If this isn't the case the Software Playeris used
automatically.

The Standard Player (DirectX) is considerably more powerful than the Software Player, however a
corresponding graphics card is required.

You will find settings for the corresponding SlideShow Player further on in this section.

Slideshow flow:
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ideshow
- Main settings
Fiona Flo
- Transitions
Music settings T
- Background music

- Diescription

- SlideS how-Player
" Standard Player [Directx)

Here you can change the Default duration of your images, as well as select to Play images in
random order.

Slideshow end:

= Slideshow

- Music settings
- Background music
- Description

£ SlideS hiowe-Player
- Standard Player [Directx]

Here you can decide what is supposed to happen at the end of the slideshow played back. Do you
want the show repeat itself or stop after the first run? You can also let the viewer decide.

Transitions:
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| Slideshow
- Main settings
- Slideshow flow

Music settings
- Background music

Loga
- SlideS how-Player
" Standard Player [Directx)

= Default

Alphablending
Bouncing
Color fading
Grow

Push away
Slide

ki)

Cube

Paper blinds
Skew
Sphere

BEEE

ER 4 )
Sl
-

Circle
[ Padar
Fladar tiles
-~ [¥] Rings

=

Here you can select which transitions are supposed to be included in the Random transition. All
those with green check marks are included, all those with a red cross are not included.

Music settings:

The music settings are explained in further detail here.

Background music:

The topic of background music is dealt with in detail here.

Description:

(= Slideshow
ain zettings
- Blideshow flow
- Transitions
- Music settings
- Background music

ogo
= SlideShaw-Plaper
* Standard Player (Direct<)

Copyright © AquaSoft GmbH 1999-2015



Settings 167

You can individually personalize your show. Here you can specify a title, author and a description of
your show.

Logo:

1=+ Slideshow

- Slideshow flow

- Transitions

- Music settings

- Background music
- Description

Sl w-Player
- Standard Player [Directs]

If you want to start your show with a Logo you can select and image here. You can also simply omit
a logo.

Standard player:

Slideshow flow
- Transitions

Background music
- Description

(= SlideS how-Plaper
ard

sutomatic fade-in and -out - = 5

The AquaSoft SlideShow Player takes on the task of playing back a slideshow. Here you can
decide the settings for it. First check which S/ideShow Player you are using. You will see this in the
Basic settings.
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Select here if you want the show to be replayed in full screen or window mode.

Use the settings for Antialiasing to remove ugly artefacts at the edges. The best way to recognize
the difference is by rotating a black square in front of a white background and closely watching the
edges. If the option is set to Automatic the level with the highest possible quality will be used. The
other option cause 2x,4x,8x,16x oversampling of the image, with correspondingly increasing effort.
This requires a lot of computing power of the graphics board and can lead to jerkiness at high
resolutions and older and cheaper boards. Nonetheless, the gain of quality is, depending on the
displayed contents, remarkable. Older graphic boards should be used with the option None.

You can also specify the setting for the Navigation bar, i.e., how and when you want it to be
displayed.

Under Control you can select if you want the show to be started automatically after clicking Play or
if you want it to wait for an input, i.e., if you want manually control your show. You can also activate
the option to control the image change with the mouse.

The IntelliLoad specifies how many seconds of the show should be loaded in advance.

If you want to use the selected settings as default for every new slideshow then click As default.
These settings will then be automatically assigned to all future shows. By clicking the button
Original settings you can reset all settings to the factory values.

9.3 Music settings

You can reach the music settings via Slideshow -> Settings -> Music settings.

Slideshow settings

= Slideshow

o Music settings
ain settings g

Slideshow fow

General

Transitions

V| Activate background music

Description v Automatically repeat title fist 7&‘ Edit litle list
Logo
Volume of background i
£ SlideGhow-Plaper R
Standard Player [Directy) Standard wolume: 1z 3
+| Fade-out of background music to slideshow end  Fade-out duration: 200 sec =

flmle music when sounds are playing
These settings apply when a zound object controlz the fade-out of background music.
Fade valurme: 40% 3 Fade duration: 030sec 5
| Fade sounds too

| Live presentation mode [music continues ta plap at pause)

4 0K LCancel Help

The Music settings can be set as desired for each show. The standard settings are illustrated.

V| Activate background music | You decide here whether background music is
supposed to be included in your slideshow or not.

v Automatically repeat title list | In the Background music menu you can insert
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o Edittitle list

Standard wolume; 1oz = l

Fade-out duratio: 200 sec 3 I

| Fade-out of background music to sideshow end |

Fade wolume: 40 %

Fade duration: D,SD.SEC = l

| Fade zounds too |

| Live presentation mode [music continues to play at pause]!

9.4 Program settings

several tracks to provide background music for
your show. Here you can decide whether this list
should be repeated if all tracks have been played
and the slideshow has not yet come to an end.

Via this button you can access the Background
music menu and can remove or insert tracks
there.

Here you can set at what volume the tracks
should be played back (100% = full volume).

Here you can specify the length of the fading out.

The background music can be gently faded out
towards the end of the slideshow or simply
broken off.

If you use Sound objects or have recorded
commentaries for your images in your show, it is
expedient to fade out the background music
when playing back these objects. Specify here to
what volume the sound should be faded out.

0% = Fade out completely
100% = Do not fade

Determines over what period of time the music
should be faded.

Here you can specify whether the background
music should also be faded with included Sound
objects.

If you use breaks and continue manually during
the show, you can decide whether the music
should also be interrupted during an image break,
or whether it should continue. If a check mark is
placed, the music stops during a break.

The Program settings refer to the basic settings of the program and not to the individual settings
for your slideshow. For the slideshow created by you, the slideshow settings are decisive.

Under Extras -> Program settings you can access the program settings.

Plugins:
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File narne:

Wersion
C:\Program Files (x86)\AquaSoft\Dia... 1.0.0.40820 OK
C:\Program Files (x86)\AquaSoft\Dia... 8.1.4.40928 OK

. C:\Program Files (x86)\AquaSoft\Dia... 4.0.1.40820 OK

= Layout designer
EF Grid
- Object grid
- Center lines

Contains a list of all plug-ins additionally installed which have been installed by additional AQuaSoft
applications.

Add files:

[Flename g it drecory (i)~

Here you can determine how files are supposed to be inserted into a slideshow and how they should
be arranged in this slideshow.

User interface:
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= Layout designer
EF Grid
- Object grid
- Center lines

Here you will find additional setting options for the user interface of AquaSoft ® SlideShow.

Temporary directory:

= Layout designer
= Grid
- Object arid
L Canter lines.
Regular

AquaSoft ® SlideShow from time to time requires temporary disk space on the hard disk. Here you can
specify in which directory temporary files may be buffered. A lot off memory is necessary during video cretion. If
the Temp directory doesn't provide enough space you can specify another directory here.

Language:
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= Layout designer
EF Grid
- Object grid
- Center lines

AquaSoft ® SlideShow supports several languages, which you can change here.

Automatic update:

= Layout designer
= Grid
- Object arid
L Canter lines.
Regular

Here you can set the intervals at which AquaSoft ® SlideShow is supposed to check for updates. This way
you stay up to date So bleiben Sie immer auf dem aktuellsten Stand. Zur Priifung wird eine Verbindung
zum Internet bendtigt.

Record sound:
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= Layout designer
EF Grid
- Object grid
- Center lines

Using the Sound Wizard you can record spoken commentaries with your images by means of a
microphone connected to your PC. Configure the recording settings here.

Default image settings:

Leave in place {do not hide) -

[l st ]

=

= Layout designer
Bl Grid

Here you can determine which settings will be used for newly inserted image and text objects.

Confirmation:

Copyright © AquaSoft GmbH 1999-2015



174 AquaSoft SlideShow - Help

[ Player - Summery dialog
Welcome Diglog

Hint Text effects

Hint Slideshow objects
Hint Movement paths
Hint Image effects
Hint Fade-ins

Hint Fade-outs

= Layout designer
EF Grid
- Object grid
- Center lines

Select the dialogs to be shown here.

Sound system:

= Layout designer
Bl Grid
- Dbject grid
- Center lines

The Sound system takes on the task of playing back the music included in the slideshow. Should
you have irregularities when playing back the music, set the setting to Windows Multimedia here
and then restart AquaSoft ® SlideShow.

CD/DVD/BD writer:
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I: (HL-DT-ST DVD+-RW GH7ON - A101) -
1% (176 KBfs) -

= Layout designer
EF Grid
- Object grid
- Center lines

Here the recognized CD/DVD/BD writers are shown.

Automatic saving:

= Layout designer
= Grid
- Object arid
L Canter lines.
Regular

Here you can determine whether backup copies should automatically be generated while you are
working on a slideshow. Under File -> Open -> Restore you can access an earlier status of your

work.

Timeline:
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= Panels
==
- Storyboard
= Layout designer
Et Grid
i Canter fines

Configure the settings of the Timeline here.

Storyboard:

= Layout de:
= Grid

L Canter lines.
Regular

signer

Configure your settings for the Storyboard.

Layout Designer:
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You can configure settings for the Layout Designer here.

In a submenu, you can determine more precisely how the Grid should look like and how the objects
are to respond to the Grid.

Image list:

= Layout designer
Bl Grid

8 Imagelist

Here you can select which information should be displayed in the Image list.
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10 Technical information

10.1 Common preparations

Directories

In order to achieve a good result quickly and effectively, you can make some minor preparations in
advance. AquaSoft ® SlideShow saves an image list and, in that respect, keeps an eye on all
directories specified.

File formats
AquaSoft ® SlideShow supports, inter alia, the following image formats.

Alias/Wavefront Images (*.rla;*.rpf) Advanced Streaming Format (*.asf)
AN Images (*.ani) AIFF files (*.aiff)

Arts & Letters Thumbnail Images (*.ged) IT/Impulse Tracker-Music (*.it)
Autodesk Images (*.cel;*.pic) MIDI-Files (*.rmid:®. rmi)

Dr. Halo Images (*.cut) MMOD-Music (*.mod)

Encapsulated Postscript Images (*.eps) MP2 files (*.mp2}
Device-independend Windows Bitmaps (*.dib) MP3 files (*.mp3)

GIF graphics from DevExpress (*.gif) 0GG Vorbis files (.ogg)

JPEG 2000 (*.jp2) S3M/Scream Tracker-Music (*.23m)
JPEG 2000 Codestream (*.jpc) WAV files (*.wav)

JPEG Images (. jfif:*.jpe™.jpeg) Windows Media Audic (*wma;* wmv)
IPG Images (*.jpg) AM/FastTracker-Music (*xm)
Kodak Photo-CD Irmages (*.pcd)

LuraWave (*.lwf) Sound formats
Paintshop Pro Images (".psp) Animated GIF (*.gif)

Paintshop Pro Frarmes (*.pfr)

C Int diate F i {*.ci
Paintshop Pro Tubes (*tub) eroninenmedista Formal Fol)

Digital Video (*.dwv; *.dif)

Photoshop Irmages (*.pdd;* . psd) DVD Video (*vob)

Portable Bitrnap Images (*.pbm) Flash Video [*flv)

Portable Gray Map Images (*.pgm) Flic Animation [*flc)

Portable Network Graphic Images (*.png) Matroska Media Container (*.mlov)
Portable pixel map Images (*.ppm) MPEG (*.mpg: *.mpeq)

Run length encoded Windows bitrmaps (*.rle) MPEG-2 Tran;pnrtstream (*.mits: *.m2ts)
SGI5W Images (*.bw) MPEG-4 (*.mpd) '

SGI True ColorImages (*.rgh;*.sgi) MPEG-4 Video (*.mdv)

SGI True Color Images with transparency (*.rghbs OGG Theora Video (*.ogv)

TIFF Graphics (*.tif;* tiff) Quicktime (*.mov)

Truevision Images (".ich:*.tga;* wda:*.vst".win) Video for mobile devices (*.3gp; *3gp2)
Windows Bitmaps (*.bmp;”.msk] Video for Windows (*.avi) r

Windows Media Video (F.wmv)

Video formats

Please note that MID and RMI files cannot be used when creating the video with the Video Wizard.

@

Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ®
SlideShow does not support the use of music tracks which have been encrypted by
DRM or similar procedures.
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10.2 Installation

To install AquaSoft ® SlideShow we suggest at least the following system setup. More resources
will lead to higher quality playback:

Hardware

CPU - 2 GHz, Multicore processor recommended

Graphics board - DirectX 9c (must support shader model 2)

RAM - 2CB

Harddrive - 150 MB (burning (S)Video-CDs may need space up to 1,2 GB for a short time, burning
Video-DVDs may take up to 10 GB temporarily)

CD/DVD/BD-burner - (optional)

Operating system

Windows XP Home and Professional, Vista, Windows 7, Windows 8. 32bit as well as 64bit systems are
supported.

not supported are the operating systems:
DOS, Windows 3.x, Windows 95, 98, ME, 2000, Unix, Linux, Apple Macintosh, Novell, etc.

10.3 Full screen mode with different screen resolution

You can modify the graphic mode for the full screen display in the player settings. When switching
the screen resolution Windows can only assign a fixed or no frame rate at all. Since we can't know
your graphics card/monitor combination we omitted the assignment of a fixed frame rate. This was
done to prevent any danger for your monitor. Windows automatically switches to one of the possible
modes, which you can change yourself. (see Control panel -> Display -> Settings)

This hint is only of interest if you want to work with a modified full screen mode. The problem does
not exist in window mode.
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11  Ordering AquaSoft ® SlideShow

The easiest way to order a product by AquaSoft is to visit our Online Shop. Here you can always find
the newest offers and also bundles (combinations of several products), which you can save a lot of
money with. In addition you'll receive the newest updates.

12  Other programs by AquaSoft

AquaSoft SlideShow is just one of many useful programs created by AquaSoft. On the following pages
you can find additional programs with interesting features and useful enhancements.

12.1 AquaSoft ® DiscMenu
AquaSoft ® DiscMenu - Your professional CD-ROM-Publishing-System

You hawe the best contents but nobody looks at them? Endless amounts of data can be stored on CDs or
DVDs. But it needs a lot of care to make these data accessible to the user. What if you could organize the
contents of your CD through easily to create HTML-pages? Great idea! What's missing now is a suitable
environment because a normal web browser for displaying the page neither looks professional nor does it
provide the opportunities to customize its look. On top of that there are quite a few obstacles to overcome.
Good that there is AquaSoft ® DiscMenu.

The start menu for your CD or DVD:

¢ the auto-start menu for your installation file and other applications
¢ the business card of your company with navigation

e your product presentation on CD or DVD as advertisement

¢ the information system for your documentation

e a new way for your multi-media application

You want to distribute eLearning-products or start eBooks, audio books, movie or sound files from CD?

AquaSoft ® DiscMenu provides the features of a multi-media authoring system!

Copyright © AquaSoft GmbH 1999-2015


http://shop.aquasoft.de

Other programs by AquaSoft

More information on the Internet: www.aquasoft.net
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12.2 AquaSoft ® PhotoAlbum

AquaSoft ® PhotoAlbum - Get more out of your photographs

Digital photos are great but they aren't everything. You will come to a point where you wish you could look at
them in print. That's way you can say, paper photographs are alive and well.

With AquaSoft ® PhotoAlbum you can offer more than just lose photos to the admirers of your artwork. No
boring albums but exciting effects give your pictures center stage. Whether you want to spice up your desktop,
produce creative photo books or wake up your printer from its hibernation is up to you. In AquaSoft ®
PhotoAlbum everyone finds what is needed.

And these are the three easy steps:
e adding images

e selecting a template

e creating the photo album

AquaSoft ® PhotoAlbum already comes with many prepared templates. But with the integrated template
editor you can design your album to the smallest details yourself, as well. There are no limits. Title pages,
chapters, thumbnail view (contact print) and much more can be designed and positioned. Create professional
photo books just as easy as funny ones, e.g. with pictures that seem like pasted in.

Enough of always the same desktop wallpaper? With the integrated Desktop-Album you can revive the
memories of your last holidays. It's not just a simple one-after-the-other of your photos but they are
professionally embedded in an interesting environment.

More information on the Internet: www.aquasoft.net
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12.3 AquaSoft ® PhotoCalendar

AgquaSoft ® PhotoCalendar - Your photos, around the year.

There's always a time to give gifts. So, what's more suitable than to give a calendar, then?

AquaSoft ® PhotoCalendar is a universal program for the creation of customized calendars. Ready-made
templates ensure the desired result with just a few clicks.

And these are the three easy steps:
e adding images

e selecting a template

e creating the photo calendar

AquaSoft ® PhotoCalendar already comes with many prepared templates. Calendars for printing or your
desktop, for giving away or keeping. Cover pages, any number of pictures per page, appointment books,
weekly, monthly, yearly calendars, etc. - leave room for your creativity. Create new calendar layouts to the
smallest detail with the help of the integrated template editor. Whether simple, advanced, funny or formal -
everything can be achieved in a professional manner.

Specify birthdays and appointments. Every event will be displayed with photos on the correct day.
PhotoCalendar also imports your appointments and birthday list from MS Outlook.

The DesktopCalendar brings your photos as a photo calendar to your desktop, including your specified events.
This too includes your MS Outlook events.

More information on the Internet: www.aguasoft.net
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12.4 AquaSoft ® ScreenShow

AquaSoft ® ScreenShow - Take a break and enjoy your pictures.

People always have been charmed by moving pictures. Put the magic of your photos on your screen. With
AquaSoft ® ScreenShow you can create your own photo screen savers with impressing transitions and
background music. And it can be done with just a few mouse-clicks. You can use these screen savers on
your own PC or you can distribute them, e.g. per eMail.

And these are the three easy steps:
e adding images

e entering a title

e creating the screen saver

More information on the Internet: www.aquasoft.net
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12.5 AquaSoft ® WebShow

AguaSoft ® WebShow - Waltzing from a photo to a website

While the Vienna Waltz uses three steps conwerts the program AquaSoft ® WebShow your photos into a
ready-to-go website. That's right! In just three steps a complete website is created including picture frames,
background, thumbnail navigation and, if you wish, transition effects.

And these are the three easy steps:

e adding images
e selecting a template
® launch the website

Whether for family or for presentations in the company, for you it is important to embed your photos and
pictures into a pleasing Internet site with just a few clicks. From the abundance of web templates you can
create a professional web project with oveniew page (thumbnails), navigation buttons and comments.

And those who want can dance the foxtrot. Then there is a fourth step available for setting the page properties
where all possible configuration can be made. E.g. you choose a picture frame, a certain background color, a
button style - even whole themes are available. Due to the powerful, XML-based scripting language of the
templates you can create your very own templates, as well. There are virtually no limits: you can use
everything that is supported bei HTML, PHP, ASP, Javascript etc. Again, you can but you don't have to.
Because AguaSoft ® WebShow has almost everything prepared for you.

More information on the Internet: www.aquasoft.net
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13 AquaSoft ®

13.1 If you have problems

The AquaSoft-homepage offers software on the topics of education, image editing and image
management as well as further shareware and freeware for download.

Visit our homepage at www.aquasoft.net. You will find downloads, FAQ, forums and information on
our products.

If you have trouble with an AquaSoft product or questions, criticism, praise, please proceed as
follows:

e Check the manual or the according help file.

Try finding an answer in the FAQ (Frequently Asked Questions).

Visit the respectivee forum. There users can exchange experiences and can ask questions.
Write your own entry. Sometimes it is easier for another user to understand the question than
for a whole team of developers - and the answer might come quicker, too.

e Only after those steps didn't succeed, write or call us. We take your suggestions as important
help, but we also need time to advance the software.

e The contact email address is: info@aguasoft.de
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